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Issues Module Overview
With the Issues Log you can keep a complete record of what all your
production and maintenance people are doing. The way this system was
planned is to make a computer available for your employees. As they
encounter issues on the floor (or elsewhere in the plant), they come to this
computer and log in whatever they may have encountered. In this fashion,
other personnel, on perhaps other shifts, can review reports and gain insight on
how things have been running. A person that has knowledge of what was done
before they became involved with a specific issue will be much better prepared
to resolve that issue.

If used right and in a consistent manner, this module can be proven to be a
great industrial maintenance tool. After just a few weeks of data entry, you will
be able to pin point problem areas, and recurring issues. This will help guide
you into the proper direction, allowing you to place resources where they are
most needed, making the work that is performed return greater results.
You may be saying to yourself right now that your employees don't have the
time to be sitting in front of a computer all day. Well, this program doesn't
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require them to. If they go and log in their issues as they are encountered, they
should only need a couple of minutes per issue, and this time shouldn't even be
noticed, but the benefits gained will surely be noticed. We have also made it so
these employees can reuse the same data over and over by providing quick
entry routines, decreasing the time needed for data entry.
The following flow chart illustrates a way the Issues log can be used to benefit
your maintenance department and production in general.

The above format will also work just as well for your production line
personnel.

Differences between Maintenance and Production Issues
The procedures outlined in this chapter work equally well for both
Maintenance and Production issues. In fact these two modules are actually the
same module, just sorted differently. It would be perfectly acceptable to have
all your employees use just one type of reporting. But many have found it
useful to keep the two separate for a variety of reasons. The choice is totally
yours and your organization.
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Entering a New Issue
This exercise will step you through the process of entering a new issue into the
program's database.

1. Click on the Home tab in the ribbon and select the Add New Record
option.
2. If you are not already there, move to the Issue Details tab by clicking it.
3. Move to Issue Date and click on the … button just to the right of this
field. This action will bring up a calendar that will allow you to change
the date of this field. Select or click on the appropriate date from this
calendar and then click the Select Date button.
4. Move to the Issue Time drop down and select the closest time as to
either when the issue first occurred or when you are reporting it. Select
this time by clicking on the arrow attached to this field, and then mouse
clicking on the appropriate time from within the list.
5. Next you need to assign the issue to a selected production line. This, as
with the majority of the fields located here is very important for
reporting purposes. To assign this issue to a production line or system,
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move to the Line or System field and click on the … button located to
its right. This will bring up the Line Names selection screen.
6. Move to the list of line names and select the production line of your
choice by clicking it. Next move to and click the Select button to insert
the selected name. For this example, lets say we entered Line One.
7. Move to the two Down Time drop down list boxes, and select the
appropriate down times, if any. For this exercise move to the Hours
drop down and select 1. Next move to the Minutes and select 15. This
would equal 1 hour and 15 minutes, or 75 minutes, depending how you
want to look at it.
8. The next item that needs attention is the Machine field. It's very
important that this field is entered prior to moving to the Problem field.
This is because the database will be sorted, and will change by the
Machine you enter. To change the machine, move to and click on the
… button to the right of the field.
9. Next move to the list of machine names and select the description of
your choice by clicking it.
10. Next move to and click the Select button to insert the selected name
into the Issues Details screen. For example, let's pretend that we
entered Conveyors as our machine.
11. Move to the Problem field and click on the … command button to
bring up a list of issues. Again this list will change depending on the
machine you've previously selected.
12. Move to the list of issues and select the issue of your choice by clicking
it. Next move to and click the Select command button to insert the
selected issue description into the Issues Details screen. For example,
let's say we choose Gearbox as our issue. When assigning issues you
want them to be rather general in nature, for reporting purposes. You'll
have a chance to be more descriptive in the Issues Details field.
13. Move to the Reported By field and click on the … button to bring up a
list of names.
14. Move to the list of names and select the name of your choice by
clicking it. Next move to and click the Select button to insert the
selected name into the Issues Details screen. For example, let's say we
entered your name.
15. Move to the Crew or Shift field and click on the … command button to
bring up a list of possible choices.
16. Now move to the list of crews and select the crew name of your choice
by clicking it. Next move to and click the Select button to insert the
selected title into the Issues screen. For example, let's say we entered
Day Crew.
17. The next step is to move to the Issue Details text box and type in any
details you may have about the current issue. For example, type the
following: The gearbox lost all its oil and locked up. Note: This field
will accept up to 2,000 characters, which should be more than sufficient
for most issues.
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18. Next click on the small command button just to the right of the Issues
Details field that has a picture icon of ABC and a checkmark. This icon
will spell check the Issues Details field.
19. Next move to the Status indicator drop down and select the appropriate
indicator that best describes the status of your recorded issues. Options
here are as follows:
 Information Only – Use this indicator to pass on information
to other personnel or shifts. This may not really indicate an
issue at all, but just a way to pass on valuable information to
others. It is recommended that you use this indicator sparingly
as it increases database size without really reporting an issue.
Example: Machine went down because operator went on break.
 Issue Resolved – Use this indicator to inform others that you
were able to repair or resolve the reported issue. Example: Had
a broken reflector on conveyor. Replaced, working fine now.
 Needs Attention – This indicator would inform others that you
were not able to fully resolve the issue and the issue needs
further attention. Example: Oil leaking from the gearbox on the
elevator. Could not find a new one to replace it with, so I added
oil to it.
 >>URGENT ISSUE<< - This indicator should be used for
ITEMS THAT WERE NOT RESOLVED and need immediate
attention to keep the machine running. If the issue has been
resolved, or the issue just needs attention, do not use this
indicator. Example: Could not repair the problem with the hoist.
Machine is running, but faults out regularly, causing a lot of
down time.

NOTE: Work Assignments (Work Orders) are easily created with Needs
Attention and Urgent Issues, allowing you to keep up on these types of issues.
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Parts Used
To record the parts used in the completion of an issue (Maintenance Issues
Only).













Select the issue by one of the lookup routines.
Move to the Open Issue tab by clicking on it.
Click on the Issue Part Usage button near the bottom right hand corner
of the screen
Click Add option in the ribbon.
Move to Group Name grid located on the left of the screen and click on
the group you believe your part would belong to. The grid on the right
will be resorted by whatever group you select. You can also place a
check in the View All Parts checkbox to view all parts, ignoring groups.
Move to the Parts List grid, located to the right of the screen and click
on the part of your choice.
Click Select in the ribbon.
Click in the Qty Used text box.
Type in the quantity you used of the selected part in the completion of
this issue.
Repeat the above steps until you have added all parts and materials you
used.
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If you wish to update your inventory levels, thereby reducing stock
levels by the amounts recorded here, move to the Update group in the
ribbon and select the Inventory Levels option.

Removing Parts and Materials from Issues
To remove a part from an issue:






Move to the Open Issue tab by clicking on it.
Click on the Issue Part Usage button near the bottom right hand corner
of the screen.
Move to the grid and click on the part you wish to remove.
Click Delete option in the ribbon.
Answer Yes to the prompt.

Printing the Issue’s Material List
To receive a print out of the materials associated with an issue:




Select the issue by one of the lookup routines.
Open the Reports tab in the ribbon and select the Parts Usage option.
From the preview screen, click Print.

Editing Issues
To change the contents of an Issue that has already been entered into the
database, please follow these steps:





From the Lookup View tab, locate the issue you want to edit from those
listed. Move through these issues using the data control found in the
toolbar, or use the scroll bar attached to the right of the list.
Once you have located the Issue you want to edit, click on it to select it.
Click on the Issue Details tab.
Edit the issue in the same fashion as it was created. For more
information refer to the section, Entering a New Issue.
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Working with Open Issues
When an issue's status has been marked as either Needs Attention or
<<URGENT ISSUE>>, the program treats these issues as open. With open
issues you can have the program create Work Orders and Work Assignments
forms for you.
Basically, a Work Order and a Work Assignment is the same thing. The
difference is that a Work Assignment deals with a production issue, and should
demand immediate attention. A Work Order on the other hand, could also be a
production issue, but would generally not require immediate action.
There are three ways to turn an open issue into a Work Assignment, and these
will be outlined next.
Method One
To generate a Work Assignment using method one, please follow these steps:





Select the issue you want to create a work assignment for from within
the Lookup View grid. You make the selection by clicking on the issues
with your left mouse button.
Click on the Reports tab in the ribbon and move to the Assignments
group.
Click on the Work Assignments option followed by Current Issue.
The Preview screen will now load with the current work assignment
form ready for printing.
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Method Two
To generate a Work Assignment using method two, please follow these steps:









Select the issue you want to create a work assignment for from within
the Lookup View grid. You make the selection by clicking on the issues
with your left mouse button.
Click on the Open Issue tab.
Click on the … command button next to the Manager field to call up
the Quick entry screen for that field. Now select the manager of your
choice from within the list by clicking on it.
Click on the Select button to insert the manager's name into the proper
field.
Repeat the above two steps for the Assigned To field.
Move to and click on the Issue Work Assignment button.
The Preview screen will now load with the current work assignment
form ready for printing.
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Method Three
Method three deals with a date range of open issues. As one Work Assignment
is created, you'll be prompted to continue on to the next issue that falls within
the date range.
To generate a Work Assignments using method three, please follow these steps:













Click on the Reports tab in the ribbon and move to the Assignments
group.
Click on the Work Assignments option followed by Date Range.
When the date range popup appears move to the Start Date field and
click the … button to bring up a calendar. Now select the starting date
for your issues from within the calendar, and click the Select button.
Next move to the End Date field and double click here to bring up a
calendar. Now select the ending date for your issues from within the
calendar, and click the Select button.
Once the dates have been setup move to and click the OK button.
The Preview screen will now load with the current work assignment
form ready for printing.
Print the report by clicking on the Print option in the ribbon.
Move to and click on the Close button.
If there is more than one open issue that fell within the selected date
range you'll be greeted with a message box asking if you wish to
continue on with the next issue. If you wish to continue click Ok,
otherwise move to and click on the Cancel button.
Repeat the top four steps until you have worked your way through all
the open issues that fell within the selected date range.
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Creating a Work Order from an Issue
Many issues are going to require the creation of a work order instead of a work
assignment to correct the issue.
To create an issue work orders:










Locate and select the issue that you want to create a work order from.
Click on the Open Issue tab.
Click the Generate Work Order button.
When asked if you want to create a work order, click Yes.
Move to the Work Order Types area and click on the option here that
best describes the type of work order you’re creating.
Move to and click on the … button adjacent to the Equipment or
Machine field. Select the name of the equipment you want to assign to
this work order from within the grid.
Click the Select option.
Move to the other fields and enter the appropriate information.
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When you’re done with this tab, click the Next button to move to the
next.
Edit the fields on the Work to Perform tab to your liking.
Click the Save and Close option in the ribbon.

Closing Open Issues
Once an issue has been taken care of in one way or another, the issue needs to
be closed out or marked as complete.

To close an open issue:




Select the issue you want to close from within the Lookup View grid.
You make the selection by clicking on the issues with your left mouse
button.
Click on the Open Issue tab.
Move to the Completion Comments text box and record any
information about the completion of the Issue Assignment you want to
record. This information will appear on some of the reports.
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Move to the … button next to the Date Resolved field, and click on it to
bring up the calendar.
Now select the completion date from the calendar by clicking on it,
then moves to and click on the Select command button.
Next move to the Completed check box and place a check here by
clicking on it with your left mouse button.

NOTE: Please note that an issue marked Needs Attention or Urgent will still be
marked that way even if it has been closed. However the issue will not show
up in any opened issues searches if the Completed check box has been
checked.

Lookup View
The Lookup View tab is basically used as a lookup and sorting tool. Here you
find all the issues in the current sort. You can select an issue for editing,
deletion, and so on by clicking on the issue within this grid. Once selected you
can click on the other tabs to view or edit the contents of that issue.

Maintenance Coordinator  Simplicity Software Technologies Inc.

17

Issues Tracking
Resorting the Database
To resort the database:





Click on the Lookup View tab to move to that screen.
Move to the Sort By drop down list and select the option that best
describes how you want the database sorted.
Move to the View Options drop down and select the appropriate option
here.
Click on the Refresh button to have the database resorted by the options
you have setup.

Reading Pane
On the Lookup View tab, you can turn on and off a reading pane that displays
the issues main details. This feature can come in handy when trying to review
or locate a particular issue or record.
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To toggle the display of the Reading Pane:


Click on the module button and select the Show Reading Pane option.

Production Numbers
Many of the reports used by this module are based on both issues and actual
production counts. For this reason we have provided a way of entering
production numbers from within this module.

To record production numbers into the database:






Click on the Module button in the ribbon then select the Enter
Production Counts option.
After the Production Count Editor screen appears, move to the list of
Lines and select the line you wish to assign numbers to by clicking on
it. The line should now be highlighted showing it is indeed selected.
Move to and click on the … button adjacent to the Date Selection field.
This date should indicate the date these production numbers should
apply to. When the Calendar screen appears, move to and select the
appropriate production date and then click the Select button. This action
will input the proper date into the Date Selection field.
Move to the Production Counts field and enter the day's total
production numbers. If a number was previously entered, it will be
changed to this new number, not added to it.
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You must click the Save button. If you change the date or line before
clicking the Save button, your entry will not be recorded. Note we have
made the Save command a default button, so if you press the ENTER
key right after entering a production number, that number will be
saved.

Printing an Issue
To print an issue record:



Select the issue you want to print from within the Lookup View grid.
You make the selection by clicking on the issues with your left mouse
button.
Click on the Print Record icon in the ribbon or click on the module
button and select the Print -> Print Record option.

Deleting an Issue
To delete a single issue from the database, please follow these steps:




Select the issue you want to delete from within the Lookup View grid.
You make the selection by clicking on the issues with your left mouse
button.
Click on the Delete Record option in the ribbon’s Home tab.
When the Delete Record screen appears click on the Yes button to
continue the deletion process. If you have changed your mind, select
the No or Cancel options.

Searching the Database
To find an Issue:





Move to the Home tab of the ribbon.
Click on the Find First option in the Search group.
Move to the Search Text field and enter your search criteria.
Move to the Search Type drop down list and select on which database
field you want to base you search on.
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If you only want to return exact matching records from your search,
place a check in the Exact Match Only check box. If this box is left
blank, the application will automatically insert wild card characters into
the search.
Click Find First button.

To find additional matches to your search:


Click on the Find Next option in the ribbon or click F3.

Using the Issue Filtering Wizard
The Filtering Wizard is used for sorting and filtering records in the grid found
on the Issues Log main screen, and is also used with reporting. We'll explain
the use of this wizard only once. You will however see it being used multiple
times.

Please follow these steps in setting up and using the Issue Filtering Wizard.


First item to setup is the Production Line Selection. Use this option to
filter out all records except those belonging to a single production line.
If you wish to include all production lines then the All Lines option
should be chosen. To select a specific line, click on the down arrow,
and then select the production line of your choice by clicking on it.
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Next you need to move to the Date Ranges section, and setup the date
range of the issues you wish to access.
Start Date – This field should indicate the start date of the date range
for your sort. Change this date by double clicking in this field, and
selecting the new date from within the displayed calendar.
End Date – This field should indicate the ending date of the date range
of the sort. Change this date by double clicking in this field, and
selecting the new date from within the displayed calendar.
Include All Dates Check Box – This check box is very important. If this
box remains checked, any date range criteria that you may have setup
will be ignored, and the program will return all dates. Removing the
check will allow the program to return only those issues that meet the
date range criteria that you have setup in this section.
Next move to the Machine Selection section. Use this option to filter
out all records except those belonging to a single machine. If you wish
to include all machines then the All Machines option should be chosen.
To select a specific machine, click on the down arrow, and then select
the machine of your choice by clicking on it.
The last section of this wizard that needs your setup is the Sort Options
section. Here you can specify two fields to sort the records by. The
records will first be sorted by the up most option first and then further
sorted by the lower option. To change these sort options click on the
arrow and select your new sort field from those listed. Available fields
are: Dates, Reasons, Machines, Lines and Reported By.
If you would like only open issues to be viewed in the sort, place a
check mark on the Include Open Records Only check box.
Once all your sorting and filtering options have been setup to your
liking move to and click on the OK command button.

Resorting the Database with the Issue Wizard
The Issues Module contains a few different options for sorting and viewing
your records. The most powerful of these options is found in the use of the
built in Filtering Wizard.
To use and access the View Filtering Wizard:




Click on the Filter tab in the ribbon.
Click on the Filter Wizard option.
Next the Issue Filtering Wizard screen should appear. For more
information on using this wizard please refer to the section titled: Using
the Issue Filtering Wizard.
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Save to History
To save a summary of a reported issue to the Equipment History log:





Select the issue you want to save within the Lookup View grid. You
make the selection by clicking on the issue with your left mouse button.
Ensure there is an Equipment record assigned to this issue. This is done
by using the Equip button adjacent to the Machine field on the Details
tab.
Click on the Details tab.
Click on the Save History button in the lower right hand corner.

Create a New Archive Database
As you continue to use this application your database is sure to grow in size.
As a database grows too large there can be performance issues such as speed,
and problems with the data itself. For these reasons it is highly recommended
that you remove data from the database in regular intervals. Either deleting
older records or archiving them to an external database can also do this for
you. In order to archive your records, you’ll first need to create an archive
database.
To create an archive database:





Click on the Module button in the ribbon.
Move to the Databases section and select the Create Archive Database
option.
Use this Save As type dialog as would any found in Windows,
specifying the name and save path of this new database.
Click the Save command button.
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Archiving your Database
To archive your database:










Click on the Module button in the ribbon.
Move to the Databases section and select the Archive Database option.
Move to the Date Range section and click on the … command button
adjacent to the Start Date field.
Select the start date for your archive from within this calendar. Click on
the Select Date button.
Repeat the above step for the End Date field. All issues that fall
between the two date ranges will be selected for archiving.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click the Archive button to remove the files from your main database
and place them into the Archive database.

IMPORTANT NOTE: Archiving files frees up valuable database space, but
this space will not be fully realized until you also perform a compact on the
database. Performing a compact will free up this valuable database space.
Please refer to the Database chapter for more details.
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Restore Records from Archive
With the Database Restore feature you have three different restore options.
You can restore every record found in the archive database, restore a date
range of records, or restore a single record. These three options will be outlined
next.

To restore all records from archive:







Click on the Module button in the ribbon.
Move to the Databases section and select the Restore Database option.
Move to the Restore Options section and click on the Restore All radio
button.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click Restore.

To restore a date range of records from archive:



Click on the Module button in the ribbon.
Move to the Databases section and select the Restore Database option.
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Move to the Restore Options section and click on the Restore Dates
radio button.
Move to the Restore Date Ranges section and click on the … command
button adjacent to the Start Date field.
Select the start date range for your restore from the calendar and click
on the Select Date button.
Repeat the above 2 steps for the End Date field to setup the ending date
of the restore range.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using the file open type dialog.
Click Open.
Click Restore.

To restore a single record from archive:








Click on the Module button in the ribbon.
Move to the Databases section and select the Restore Database option.
Move to the Restore Options section and click on the Restore One radio
button.
Move to the Issue ID or Work Order to Restore field and type in the
Issue ID number.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click Restore.

Deleting a Date Range of Issues
To permanently remove a date range of issues from the database:





Click on the Module button in the ribbon.
Move to the Databases section and select the Delete Date Range
option.
Select the ending date for this deletion from the calendar, and click the
Select Date button. All issues that fall on or before this date will be
permanently removed from the database.
Next you’ll be notified of how many records will be deleted, and given
your last change to back out. To continue with the deletion, click the
Yes button to the prompt. If you have changed your mind, click any of
the other two buttons.
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Reports Overview
One of the main things that make the Issues Log so valuable is the reporting
features. With the built in reports it should be an easy task for you to find
problem areas and trends that can then be addressed.
One suggestion on the use of these reports is to generate them the day before a
PM. What this will help you do is find areas that need attention while the line
is down. The program is rich with reports that allow you to report on a single
production line.
Another outstanding use of some of these reports is the sharing of information
with others. Especially between your maintenance personnel, where one person
can easily find out what the other persons done even if these two people never
lay eyes on each other. The lack of communication between maintenance
personnel can at times lead to a lot of unnecessary down time, where one
mechanics duplicates or undoes the actions of another.

Master Summary Report Wizard
We expect that the Master Summary Report will be one of your most used
reports and because of this reason we have attached it to the Tasks Panel on
left side of your screen
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To use the Master Summary Report Wizard:












Click on the Reports tab in the ribbon, and then choose the Summary
Report option in the Master group.
After the report wizard loads, move to the Report Elements section of
the screen and place a check mark by the elements you want included
in the report. The following is a brief description of these elements.
o Scheduled Maintenance - Placing a check mark here will show
all the scheduled `Planned Maintenance' that is scheduled for
the given date range.
o Maintenance Issues – Placing a check mark here will include all
the Maintenance Issues reported for the given date range.
o Production Issues – Placing a check mark here will include all
the Production Issues reported for the given date range.
o Resolved Issues – Placing a check mark here will show all the
open `maintenance' issues that have been resolved within the
given date range.
o Replacement Parts – Placing a check mark here will report on
all the parts that were used by the maintenance people for the
given date range.
o Production Numbers – Placing a check mark here will report on
any reported production for the given date range.
Next move to the Sort Issues by list box and select the way you want
the report sorted. Select an option by clicking on it from within the list.
Next move to the Report Dates section and set up the Start and End
Dates of the report. Change these dates by clicking on the … command
buttons to the right of the date fields to bring up a calendar. Then click
on the new date from within the calendar, and then clicking the
SELECT command button to accept that date.
Next move to the Production Cut-Off Time section and select the Start
and End Time from the two drop down list boxes. These times will
filter out all production issues reported that do not fall within the
specified date and times. This feature is useful when you want to report
for a single shift for example.
If you would like to ignore the production cut off times, remove the
check mark on the Use Cut-off check box by clicking on it.
To group your reports, Lines, Manager or Machine, open the Group
Issues By drop down and select one of the available options found
there.
Once everything has been setup to your liking, move to and click on the
OK command button.

SAVING AND OPENING MASTER SUMMARY REPORT SETUPS
You may wish to save certain setups for later reuse. This could come in handy
when you have different shift setups, and you don't want to reselect everything
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each time. By using the SAVE command you can save the current setup to file
for later reuse. All Wizards setting will be saved except for the date ranges.
To save your setup just move to and click on the Save command button. Then
use the displayed dialog screen as you would with any program running under
Windows.
To open a saved setup file, just move to and click on the Open command
button, and then use this dialog in the same fashion as you would use any
Windows file open dialog.

Issues Report Wizard
This is a complete issues report, reporting on all issues within a given date
range, and all the other criteria that you setup, such as production lines,
machines, and sort options.

To create a report with the Issues Report Wizard:



Click on the Reports tab in the ribbon, and then choose the Issues
Wizard option in the Issues Reports group.
Following the procedure as outlined in the following section: Using the
Issue Filtering Wizard.
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Production Counts and Issues Reports
There are 3 different Production counts and Issues Reports available. All three
of these deal with the same basic information, the production counts for a
given date period, a specific production line, and all the issues report for the
date range and line.
These reports are ideal at pin pointing exactly how a production is performing
along with any reported issues. We highly recommend using one of these
reports prior to any maintenance days. This way you can see where to assign
your resources to get the best results.
To use one of the Production and Issues Report:








Click on the Reports tab in the ribbon, and then choose the Counts and
Issues option in the Production group.
Next click on the report option of your choice.
Move to the Date field and click on the … button adjacent to this field.
For the 7 days and 14 days summary reports, select the ending date for
your report. For the Month Summary Report select and date within the
month you want to report on.
Click the Select Date button.
Next the Format Report Chart screen will appear with production
count information for the given date range. For information on how to
format this chart see the charter titled Chart Designer.
Once done with formatting your chart, click on the Close button.

Top 10 Issues Report
This report returns the frequency of recurring issues for the entire plant, line or
machine, and date range you select. This report is ideal for pin pointing the
number one problem area, and then breaking down that issue even further. In
summary, this report returns the top 10 recurring issues with actual counts, for
the criteria that you setup.
To create Top Ten Issues Report:



Click on the Reports tab in the ribbon, and then choose the Top Ten
Issues option in the Issues Report group.
Following the procedure as outlined in the following section: Using the
Issue Filtering Wizard.
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Issues Status Report
The Issues Status Report uses a wizard to assist you in creating reports on
issues status, and issues that fall within a specified date range. This report will
help you stay on top of your open issues.

To create an Issues Status Report:








Click on the Reports tab in the ribbon, and then choose the Status
Report option in the Issues Report group.
Move to and click on the … button adjacent to the Start Date field, and
select a starting date for the issues you want to report on from the
popup calendar.
Repeat the above step for the Ending Date field.
To report on all issues, regardless of their dates, place a checkmark in
the Use All Dates checkbox.
Move to the Status Indicator drop down list and select the appropriate
option.
Repeat the above step for the Group By and Issues To Include drop
down list.
Click on the Ok button.
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Parts Usage Report
This report will return a list of all parts that were used in the completion of
issues, and that fall within a given date range.
To create a Part Usage Report:






Click on the Reports tab in the ribbon, and then choose the Parts Usage
option in the Issues Report group.
Move to and click on the … button adjacent to the Start Date field, and
select a starting date for the issues you want to report on from the
popup calendar.
Repeat the above step for the Ending Date field.
To report on all issues regardless of dates, place a checkmark in the
Use All Dates checkbox.
Click Ok.

Downtime Report
The Downtime reports will report on total downtime for criteria that you setup.
This information is taken directly from reported issues.

To create a report with the Issues Report Wizard:
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Click on the Reports tab in the ribbon, and then choose the Downtime
Report option in the Issues Reports group.
Following the procedure as outlined in the following section: Using the
Issue Filtering Wizard.

Predictive Maintenance Report
This report provides a worksheet based on part replacement as it applies to
Issues Part Usage. The report gives information about the replacement
intervals of parts that have been replaced more than once. With this
information the user should be able to predictive the failure rate of the reported
parts, and schedule maintenance accordingly.
To Predictive Maintenance Report:


Click on the Reports tab in the ribbon, and then choose the Predictive
Maintenance option in the Predictive group.

Maintenance Coordinator  Simplicity Software Technologies Inc.

33

Issues Tracking

Maintenance Coordinator  Simplicity Software Technologies Inc.

34

MAINTENANCE COORDINATOR SYSTEM

Projects Planner

Maintenance Coordinator  Simplicity Software Technologies Inc.

2

Projects Planner
Table of Contents
Table of Contents ................................................................................................................ 3
Project Planer Overview ..................................................................................................... 4
Project Planner Ribbon ....................................................................................................... 5
Project Planner Module Button ........................................................................................... 5
Creating a New Project ....................................................................................................... 6
Entering and Editing Tasks ................................................................................................. 7
Deleting a Task ................................................................................................................... 9
Tracking a Task Completion ............................................................................................... 9
Edit a Project Setup ........................................................................................................... 10
Print Preview..................................................................................................................... 11
Printing Your Project ........................................................................................................ 11
Opening a Saved Project ................................................................................................... 11
Saving a Project File ......................................................................................................... 11
Project Report ................................................................................................................... 12

Maintenance Coordinator  Simplicity Software Technologies Inc.

3

Projects Planner
Project Planer Overview
The Project Planner module was included with the Maintenance Coordinator
program to provide you manager types out there with a means of managing
your occasional projects. If your normal duties require a great deal of project
administration this module will more than likely be too limited for your use.
But if you only have occasional projects to manage, such as those a
maintenance supervisor might encounter, you may find this module of value,
and save you from having to purchase a more costly one.

With this module you can create a single day, divided by half-hour projects, or
ones lasting months. An example of a single day project could be maybe laying
out duties for a single day plant shutdown. Allowing you to assign tasks to
different individuals and making start and end time assignments. Where the
other maybe to plan a new production line where you would plan when each
phase would commence and end.
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Project Planner Ribbon
To help ease in the creation and administration of your project and its tasks, we
have included a ribbon. The elements of this ribbon are outlined next:







New Project – Creates a new project, replacing the current project.
Project Settings – Opens the project properties dialog.
Project Report – Print preview of the project’s report.
Edit Task – Opens the task setup dialog.
Delete Task – Erases the selected task from the project.

Project Planner Module Button
The following is an outline of the elements of the Project Planner’s Module
button or menu:






Open Project – Opens a project file saved to disk.
Save Project – Save the current project to file.
Print – Provide printing options
o Print Report – Prints the current project.
o Preview Report – Opens the print preview screen.
Close – Exits this module.
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Creating a New Project
The first task you'll be required to perform in the use of this module will be in
the creation of a new project. The steps to perform this task will be outlined
next.




Click on the New Project option in the ribbon.
Move to the Project Title text box and type a brief description of the
project you are planning.
Move to the Project Type area and select the project type option button
that best fits the project you are creating. The following options are
available:
o Single Day / Hourly Project – This option allows for a project
that will be completed in a single day, and broken into half-hour
intervals.
o Multiple Days Project – This option allows for the creation of a
multiple days or even months project. The project intervals are
broken into days.
o Multiple Days / Hide Weekends – This option is the same as the
above option, except weekends are hidden.
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If you choose a Single Day type project next move to the Single Day
Setup area and setup the Start Time and End Time of the project. Setup
these times by clicking on them from within the drop down list boxes.
If you choose one of the Multiple Days project you need to move to the
Multiple Days Setup area and setup the Start Date and End Date of
your project. Select these dates by clicking on the … command buttons
and then selecting the dates from the popup calendar.
Move to the Planner Notes section and record any notes you wish to
record about the current project.
Once everything is setup on this screen to your liking, click on the OK
command button to create your new blank project.

Entering and Editing Tasks

Once a blank project has been setup, its time to add or edit the tasks for that
project. To edit tasks please follow these steps:


Move to the row in the grid that you want to add or edit a task, and
double mouse click in the left most column of that row. You can also
choose the Edit Task option in the ribbon. This action will bring up the
Task Setup screen.
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Move to the Task Description field and type in a brief description of the
task to be created. You can enter a somewhat more descriptive
description in the Notes section on the Resources / Notes tab.
Move to the Schedule Start and Finish Dates or Schedule Start and
Finish Times sections, depending on your project type, and setup the
criteria for the current task.
Move to and click on the Resources/Notes tab.
Move to the Resource Assignments section and type in the names that
are assigned to the task you are creating.
Move to the Task Notes section and type whatever information here
you wish to record about the current task.
Click on the Time Line Fill tab to move to that section.
Move to the Fill Color section and click on the Set Color button.
Select the color you want to use for your time fill and then click OK.
Move to the Fill Anchor Graphics section and select the graphic you
want to use to anchor the time fill from those listed in the Change
Anchor dialog box.

Once everything is setup for the current task to your liking, move to
and click on the OK button.
The task should now show up on the main screen filling the time slot
range that you have just setup.
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Deleting a Task
To delete a task:




Click in the row that contains the task you want to delete.
Click on the Delete Task option in the ribbon.
When prompted about the deletion, click the Yes button.

Tracking a Task Completion
To track the completion of a given task:






Move to the row in the grid that contains the task you want to work
with and double mouse click in the left most column of that row. This
action will bring up the Task Setup screen.
Move to and click on the Completion tab.
Move to the Percent Completed section and select at what percent the
task has been completed.
Move to the Completion Notes section and record any information here
that you feel applies.
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Click on the OK button to save your changes.

Edit a Project Setup
Once a project has been setup you are limited as to how much of this setup you
can change. Basically, all you're allowed to change is the Project Title and the
Planner Notes. To change these two items please follow these steps.





Click on the Project Settings option in the ribbon.
Move to the Project Title and Planner Notes sections and edit these
fields to your liking.
Click on the OK button to save your changes.

Sorry, but once created the date range or project type settings cannot be
changed.

Maintenance Coordinator  Simplicity Software Technologies Inc.

10

Projects Planner
Print Preview
To receive a print preview of your project:



Click on the Module button.
Move over the Print option and then click on Print Preview.

Printing Your Project
To sent a copy of your project to your printer:




Click on the Module button.
Move over the Print option and then click on Print Project.
When the Print dialog appears move to and setup the various options
on this window, and then click on the OK button.

Opening a Saved Project
To open or reload a saved project, you must:




Click on the Module button.
Click on the Open Project option.
Use this File Open dialog screen as you would use any File Open
dialog found in Windows.

Saving a Project File
To save a project to disk, please follow these steps:




Click on the Module button.
Click on the Save Project option.
Use this File Save dialog screen as you would use any File Save dialog
found in Windows.
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Project Report
The Project Report will supply you with a summary of the project’s setup,
along with a summary of each of its tasks.

To generate a Project Report:


Click on the Project Report option in the ribbon.
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Mechanics Overview
The Mechanics module is used to store important information about your work
force. Information found here includes their position, address, telephone
numbers, emergency contacts and more.
Please note that this mechanic database is the same database used by the
Scheduler module where you create work assignments.
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Lookup View
The Lookup View shows you the current database and its current sort in table
form. This table format helps facilitate a faster lookup of your database
records. You can change the sort order of the table by accessing the Sort by
drop down list box, and then selecting a sort option from within this list. Once
an option has been clicked on, the database will be resorted by this selection.
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Adding a New Mechanic
To add a new mechanic:







Click on the Home tab of the ribbon
Click on the Add New Record option in the ribbon’s Records group.
Move to the Details View tab by clicking on it.
Move to the various fields and enter the appropriate information for
that field.
When you are done with one field, use your tab key to move to the
next.
To ensure that all information is written back to the database, click on
the Post/Save Changes option in the ribbon’s Records group.

Mechanic’s Reference Field
This field, found on the Details View tab should contain a unique identifier for
each different employee in the database. We did not however make this a
mandatory rule as everyone has their own way of doing things. You can
however verify if the identifier you’ve entered is unique to the database.
To test to see if your identifier is unique:




Enter your Reference ID in the space provided.
Move to and click on the Check button adjacent to this field. The
program will then inform you as to whether a matching identifier was
found.
If you click on the REF button also adjacent to the Reference ID field,
the program will automatically assign a unique ID.

Entering HR Information
Once an employee’s record has been created, more detailed information can be
recorded for that individual by entering HR type information.
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To add HR information to a mechanic’s record:




Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Move to the various fields found on this tab and record the appropriate
information for that field.

Recording Completed Training
You can record and keep track of training that your employees have
completed. This information can be useful at promotion time for example,
when you want to see just how qualified an employee is for an open position.
This is just one example, I’m sure you can think of others.
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To record completed training:







Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Click on the Training and Completed Courses tab near the bottom of
the screen
Click the New button.
When the Training screen appears, move to the various fields and
record the appropriate information for that field.
Click the Ok button.

Editing Training Information
To edit an employee’s training records:







Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Move to the Training and Completed Courses tab and click on the
record you want to edit from within the grid.
Click the Edit button.
When the Training screen appears, move to the various fields and
record or edit the information found in that field.
Click the Ok button.
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Deleting Training Information
To edit an employee’s training record:






Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Move to the Training and Completed Courses tab and click on the
record you want to delete from within the grid.
Click the Delete button.
Click Yes when prompted about the deletion.

Recording Activities
You can record and keep track of activities related to each employee such as
leaves, renewals, vacations and other general time related schedules. This
information can be valuable to your organization, and you can both run reports
on this information along with print calendars of activities.

To create a new activity:








Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Click on the Activities tab near the bottom of the screen
Click the Add Schedule button.
When the Employee Scheduler screen appears, move to the various
fields and record the appropriate information for that field.
Select the appropriate activity type by clicking on the choices available
in the Activity Type drop down box.
Click the Save button.

Editing Activity Information
To edit an employee’s training records:
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Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Move to the Activities tab and click on the record you want to edit from
within the grid.
Click the Edit Schedule button.
Move to the various fields and record or edit the information related to
that field.
Click the Save button.

Deleting Activity Information
To edit an employee’s activity schedule:






Locate the mechanic of your choice through one of the lookup routines.
Click on the HR Information tab.
Move to the Activities tab and click on the record you want to delete
from within the grid.
Click the Delete Schedule button.
Click Yes when prompted about the deletion.
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Adding a Mechanic’s Picture
To add a picture to your Mechanic’s record:






Locate the Mechanic’s record you want to work with by using one of
the lookup routines.
Move to the Details View tab by clicking on it.
Move to the Picture section of the screen and click on the Browse
button.
Use this File Open type dialog as you would any file open dialog found
in windows. Select the picture file you want to use.
Click the Open button.

Removing a Mechanic’s Picture
To remove a mechanic’s picture:





Locate the Mechanic’s record you want to work with by using one of
the lookup routines.
Move to the Details View tab by clicking on it.
Move to the Picture section on the screen and click on the CLEAR
command button.
When asked if you are sure that you want to perform this operation,
click the YES button.

Employee’s Notes
You can include a complex set of notes to be attached to each one of your
employee files. The size of the note files are limited by available disk space,
and are saved within the main database. The editor used for the notes section is
actually a small word processor, and contains many of the features of
commercial word processing programs. To find how to use the features of this
word processor please refer to the Word Processor chapter.
To access the mechanic’s notes:
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Locate and select the mechanic you want to work with.
Move to the Details View tab by clicking on it.
Click on the Notes button.

Documents
You can maintain many other documents and pictures dealing with your
mechanics by accessing the Documents feature. To learn how to work with this
documents feature, please refer to the Common Features chapter.
IMPORTANT NOTE: The Documents Feature in this module differs from
the other modules as these documents are attached to each employee’s file
or record, whereas with most of the other modules the documents are not
attached to any specific record.
To access an employee’s documents:




Locate and select the mechanic you want to work with.
Move to the Details View tab by clicking on it.
Click on the Documents button.

Deleting a Mechanic from the Database
To delete a mechanic from the database:




Locate the Mechanic’s record you want to delete using one of the
lookup routines.
Move to the Records group in the ribbon and select the Delete Record
option.
When asked if you are sure that you want to perform this operation,
click the Yes button.

Searching the Database
To find a mechanic:
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Click on the Find First option in Home tab’s Search group, or click Ctrl
- F.
Move to the Search Text field and enter your search criteria.
Move to the Search Type drop down list and select which database field
you want to base you search on.
If you only want to return exact matching records from your search,
place a check in the Exact Match Only check box. If this box is left
blank, the application will automatically insert wild card characters in
to the search.
Click the Find First button.

To find additional matches to your search:


Click on the Find Next option in the ribbon or click F3.

Printing a Mechanic’s File
To send a copy of a mechanic’s file to a printer:






Locate the Mechanic’s record you want to print using one of the lookup
routines.
Move to the Home tab in the ribbon.
Click on the Preview Record option in the Print group
After the Report Preview screen loads, move and click on the icon of a
printer to print the document.
Click on the OK from the Print Dialog screen.
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Accessing the HR Calendar
The HR Calendar is used to show scheduled activities as it relates to your
employees in calendar form. You can display, print and create new activities in
single day, week, work week, and month views. It supports schedules for
training, renewals, vacations, leaves and other general types.

To access the HR Calendar:



Move to the Home tab in the ribbon.
Move to the Employees group and select the Calendar option.

Adding a New Schedule
To add a new scheduled activity to the HR Calendar:
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Open the HR Calendar
Move to the Create group in the ribbon and select Add New.
Move to the Start and End Date fields and click on the … buttons
adjacent to these fields to set these dates.
Click on the … button adjacent to the Employee field and select an
employee from the lookup, and assign them to this schedule.
Move to the Activity Type drop down and select an activity type that
best matches the one you’re creating.
Move to the Comments field and add any comments.
Click in the Save button.

HR Calendar Legend
Each task type in the calendar has a color assigned to it. To view the legend:



Open the HR Calendar.
Click on the Legend option in the ribbon.
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Print the HR Calendar Schedule
To receive a print out of the current HR Calendar view:







Open the HR Calendar.
Select the view option of your choice.
Click on the Print Schedule option in the ribbon
Setup the elements of the Page Setup screen to your liking.
Click on the OK button.
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When the Preview screen loads, move to and click on the Print button
to print the calendar.

HR Calendar Views
There are different views available to the HR Calendar, to change these views:



Open the HR Calendar.
In the ribbon, move to the Calendar View Options group and select
click on the view option of your choice.

HR Calendar Filter Options
There are a few options as to what information to display on HR Calendar. To
change or set the filter options:



Open the HR Calendar.
In the ribbon, move to the Filter Options group and click on the filter
option of your choice.
o Training – This option shows only scheduled training.
o General – This option show schedules in the General types,
along with renewals, vacations and leaves.
o Renewals – This option shows all scheduled renewals only.
o Vacations – This option shows all scheduled vacations only.
o Leaves – This option shows all scheduled leaves only.
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Training Report
With this report you can see what certifications are coming up for renewal, and
also report on a single course description, and find who has completed it.

To create a training report:










Click on the Reports tab in the ribbon and then select the Training
Report option.
Move to the Report Title field and enter a title for your report.
Move to the Base Report On section and enter the appropriate
information in the Description field. This field points to the course
description fields, such as Forklift Certification, Annual OSHA
training, and other related information.
To ignore a specific course description, and base your report on all
courses, place a check in the Use All Descriptions checkbox.
Move to the Renewal Date Ranges section and click on the … button
adjacent to the Start Date field.
Select a date from the popup calendar and click the Select Date button.
The dates for this section are renewal, or re-certification dates.
Repeat the above step for the End Date field.
To use all dates, regardless of any renewal date setups, move to and
place a check in the Ignore Date checkbox.
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Move to the Sort Report By drop down list and select how you want
your report sorted.
Click the Ok button.
After the Report Preview screen loads, move and click on the Print
button to print the document.
Click on the OK from the Print Dialog screen.

Telephone List Report
To create a telephone list report:




Click on the Reports tab in the ribbon and then select the Telephone
List Report option.
After the Report Preview screen loads, move and click on the Print
button to print the document.
Click on the OK from the Print Dialog screen.

Address List Report
To create an address list report:




Click on the Reports tab in the ribbon and then select the Address List
Report option.
After the Report Preview screen loads, move and click on the Print
button to print the document.
Click on the OK from the Print Dialog screen.

Calendar Reports
There are a few reports available as they related to scheduled activities and the
built-in HR Calendar. To access these reports:



Click on the Reports tab in the ribbon.
Move to the Calendar Reports group and select the report of your
choice.
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o General Report – This option show schedules in the General
types, along with renewals, vacations and leaves.
o Renewal Report – This option shows all scheduled renewals
only.
o Vacation Report – This option shows all scheduled vacations
only.
o Leaves Report – This option shows all scheduled leaves only.
When the Select Date Range dialog pops up, move the … button
adjacent to the Start Date field and setup the starting date of your report
range.
Click the … button adjacent to the End Date field and setup the ending
date of your report range.
Click on the Accept button to create the report.
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Overview
The Tools module was designed to help you keep track of your tools inventory.
With this module you can maintain all the important information on each of
your tools. This includes the description of the tools, serial numbers, asset
numbers, storage locations, a picture of the tool and more. The program tracks
the complete check out history of the tool, including when the tool should be
returned, and who has it.

This module also tracks the inspection history of your tools. This is valuable,
as OSHA requires electrical tools, and such to be inspected at regular intervals.
These inspection records can be printed and kept in a safe place to prove
compliance to these regulations. By running one of the built in reports the
program can flag when these tools are due for re-inspection. Some of the other
available reports include tools that are over due for return, all available tools,
and all tools currently checked out.
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Lookup View
The Lookup View tab acts much like a lookup table. Here you simply click on
the tool of your choice to select it. Once selected you can move to the other
tabs to view or edit it.

To resort the database:



Move to the Lookup View tab.
Select a sort option from the Sort By drop down list. The database will
be sorted by whatever field you selected from this list.
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Adding a New Tool
To add a new tool:






Move to the Home tab in the and select the Add New Record option.
Move to and click on the Details View tab.
Move to the various fields and enter the appropriate information for
that field.
When you are done with one field, use your tab key to move to the
next.
Click on the Post/Save Changes button in the ribbon to ensure your
information is posted back to the database/

Adding a Tool's Picture
To add a picture to your Tool's file:






Locate the Tool's record you want to work with by using one of the
lookup routines.
Move to and click on the Details View tab
Move to the Picture section of the screen and click on the Browse
button.
Use this File Open type dialog as would any file open dialog found in
windows. Select the picture file you want to use.
Click the Open button.

Removing a Tool's Picture
To remove a Tool's picture:





Locate the Tool's record you want to work with by using one of the
lookup routines.
Move to and click on the Details View tab.
Move to the Picture section on the screen and click on the Clear
button.
When asked if you are sure that you want to perform this operation,
click the Yes button.
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Deleting a Tool from the Database
To delete a Tool from the database:




Locate the Tool's record you want to delete using one of the lookup
routines.
Move to the Home tab in the ribbon and click on the Delete Record
option.
When asked if you are sure that you want to perform this operation,
click the Yes button.

Printing a Tool's File
To send a copy of a Tool's file to a printer:





Locate the Tool's record you want to print using one of the lookup
routines.
Move to the Home tab in the ribbon and click on the Print option.
After the Report preview screen loads, move and click on the icon of a
printer to print the document.
Click on the OK button from the Print Dialog screen

Searching the Database
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To find a tool:







Move to the Home tab in the ribbon and click on the Find First option
or click Ctrl - F.
Move to the Search Text field and enter your search criteria.
Move to the Search Type drop down list and select on which database
field you want to base you search on.
If you only want to return exact matching records from your search,
place a check in the Exact Match Only check box. If this box is left
blank, the application will automatically insert wild card characters in
to the search.
Click Find First button.

To find additional matches to your search:


Move to the Home tab in the ribbon and click on the Find Next option
or click F3.

Checking Out a Tool

To checkout a tool to an employee:
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Locate the Tool's record you want to checkout using one of the lookup
routines.
Move to the Home tab in the ribbon and select the Check In-Out option.
In the Employee section type in the person's name and reference in the
spaces provided, or click on the Lookup button.
Locate and select the person you are checking the tool out to from
within the grid. You can also use the Find and Find Next routines to
locate the desired person. This works in the same way as the tools Find
function explained earlier. This grid contains all the mechanics as setup
in the Mechanics database.
Click the Select button.
Click the … button next to the Check-Out Date field.
Select the correct date from within this calendar, and then click the
Select Date button.
Repeat the process for the Due Date field.
Move to and click the OK button.

Returning a Tool
To check-in a tool:






Move to the Home tab in the ribbon and select the Check In-Out option.
Click the … button next to the Check-In Date field.
Select the correct date from within this calendar, and then click the
Select Date button.
Move to the Tool Condition field and type in the condition you feel the
returned tool is in, such as excellent, good, damaged, etc.
Move to and click the OK button.

Accessing the Notes Section
Each tool in your database can have it's own notes attached to its file. Use
these notes to record whatever information you would like at the particular
tool. These notes are actually part of an internal word processor with many
professional features.
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To access notes:


Click on the Home tab in the ribbon and select the Tool’s Notes option.

For more information on using the editor associated with these notes, please
refer to the Word Processor chapter.

Checkout History
Each tool maintains a checkout history for that tool. Information recorded in
this history database are the dates the tool was checked out, return dates, the
person that checked out the tool, their reference ID, and the condition of the
tool when it was checked back in. This information can be of value when
trying to identify when a tool was missed used, and so on.
To view the checkout log:




Locate the Tool's record you want to view the history on by using one
of the lookup routines.
Click on the Home tab in the ribbon and select the Check-Out History
option.
Use the scroll bars or data control to move through the records.

Printing the Check-Out History
To print the complete checkout history for a tool:





Locate the Tool's record you want to view the history on by using one
of the lookup routines.
Click on the Home tab in the ribbon and select the Check-Out History
option.
Select the History Report option in the ribbon.
From the Report Preview screen click the icon of a printer
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Deleting a Check-Out History Entry
To delete a record from the Checkout History log:






Locate the Tool's record you want to view the history on by using one
of the lookup routines.
Click on the Home tab in the ribbon and select the Check-Out History
option.
Using the scroll bars or data control locate the record you want to
delete from within the grid. Click on this record to select it.
Select the Delete Record option in the ribbon.
Follow on screen instructions.

Deleting a Date Range from the Check-Out History Log
As you use the database for sometime, your checkout logs may grow to be
quite large. For this reason we have provided you with a way of deleting many
records at once.
To delete a date range of records:





Click on the Home tab in the ribbon and select the Check-Out History
option.
Select the Delete Range option in the ribbon.
Select the ending date for the deletion from the calendar, and then click
the Select Date button.
When asked as to whether you want to continue, click the Yes button.

Notice: All records on and before the date selected will be deleted from the
database.

Inspections
As you know, tools need to be inspected at regular intervals to ensure their safe
use. This is especially true when dealing with power tools, etc. I even believe
you'll find an OHSA regulation or two dealing with this subject. With the built
in inspection handling routines you'll find that keeping these inspections up to
date is much easier to do than maybe originally thought.
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With the inspections routines contained in this module you'll be able to set at
what interval these inspections should take place. Keep a record of all past
inspections, and by running one of the available reports, see what inspections
are either coming due, or over due.

Setting Up the Default Days between Inspections
To setup the default days between tool inspections:




Click on the module button and select the Days between Inspections
option.
Type in the default value you want to setup in the space provided, in
days.
Click the OK button.
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Recording a New Inspection Record

To record a new inspection record:








Locate the tool that contains the records you want to record an
inspection for by using one of the lookup methods.
From the Home tab of the ribbon select the Tool’s Inspections option.
From the Tool Inspections tab click on the Add Entry option.
Click the … button adjacent to the Inspection Date field.
Select the inspection date from within the Calendar and then click the
Select Date button.
Move to by the Inspected By and Comments fields and type in the
appropriate information.
Click the OK command button.

Note: That when a new inspection has been recorded, the next inspection date
will be automatically calculated for you. This new inspection date is the date of
the inspection plus the default days between inspections that you have setup.
This new or Next Inspection date is displayed on the Details tab.

View or Edit an Inspection Record
To view or edit an existing inspection record:



Locate the tool that contains the records you want to record an
inspection for by using one of the lookup methods.
From the Home tab of the ribbon select the Tool’s Inspections option.
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Locate the record you want to edit from within the grid, and click on
the record to select it.
From the Tool Inspections tab select the Edit Entry option or click the
Edit icon in the toolbar.
Edit the record by changing the fields to reflect the changes you want to
make.
Click the OK button.

Print an Inspection Record
To print a tool's inspection record:





Locate the tool that contains the records you want to record an
inspection for by using one of the lookup methods.
From the Home tab of the ribbon select the Tool’s Inspections option.
From the Tool Inspections tab click on the Print List option.
Move to and click on the icon of a printer.

Delete an Inspection Record
To delete a record for a tool's log:






Locate the tool that contains the records you want to record an
inspection for by using one of the lookup methods.
From the Home tab of the ribbon select the Tool’s Inspections option.
Locate and then click on the record you want to delete from within the
grid.
From the Tool Inspections tab select the Delete Entry.
Click on the Yes button when prompted as to whether you want to
continue or not.

Delete a Date Range of Inspection Records
To delete a date range of records:



Locate the tool that contains the records you want to record an
inspection for by using one of the lookup methods.
From the Home tab of the ribbon select the Tool’s Inspections option
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From the Tool Inspections tab select the Delete Range option.
Select the ending date for the deletion from the calendar, and then click
the Select Date button.
When asked as to whether you want to continue, click the Yes button.

Notice: All records on and before the date selected will be deleted from the
database.

Filtering the Database
There are a few different ways if filtering the database to allow to see just the
items you want to view.
To filter the database:



Move to and click on the Filters tab in the ribbon.
Select the option of your choice that best describes how you filter the
records.

All Past Due Tools Report
This report returns all the tools that are currently checked out and over due for
return.
To create a All Past Due Tools Report:



Move to and click on the Reports tab in the ribbon.
Select the All Past Due option in the Checked Out group.

All Currently Checked Out Tools Reports
This report returns all the tools that are currently checked out.
To create an All Currently Checked Out Tools Report:



Move to and click on the Reports tab in the ribbon.
Select the All Checked Out option in the Checked Out group.
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All Currently Available Tools
This report returns all the tools that are currently available for checked out.
To create an All Currently Available Tools Report:



Move to and click on the Reports tab in the ribbon.
Select the All Available option in the General Lists group.

All Tools Report
This report returns all the tools, checked out, or otherwise.
To create an All Tools Report:



Move to and click on the Reports tab in the ribbon.
Select the All Tools option in the General Lists group.

Up Coming Inspections Report
This report will show all inspections that are due to be performed that fall
before a date that you specify. The reports can be used to both report on or up
coming inspections, and on past due inspections.

To create a Inspections Coming Due report:





Move to and click on the Reports tab in the ribbon.
Select the Upcoming Inspections option in the Inspections group
Select the ending date from within the calendar by clicking on it.
Click the SELECT DATE command button.
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Overview
One thing I'm sure any maintenance department could use is a database full of
Troubleshooting procedures and other related information. Well, with the
Maintenance Coordinator's Procedures and Solutions module we allow you to
build just this. With this module you can begin building a complete database
full of useful procedures. In this way as mechanics learn new techniques on a
machine, they go to this module and enter this information. As other
mechanics work on the same machines they return to this module and look up
these procedures for their own personal use.

The more information that can be shared between members of you
maintenance and production teams the better. If someone has solved a complex
problem before, and that problem arises again with a different person, wouldn't
it be nice to know what the other person did when they fixed it? Of course it
would. Knowing what the other person did could save a lot of down time by
already knowing a couple of possible fixes.
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This module allows you to breakup your procedures under a couple of different
categories for easy identification and retrieval. These categories are first
grouped by Group, then by Sub-Groups, and finally by the procedures
themselves. For example, you could have something setup like the following:
Group:
Sub-Group:
Procedure:

Forklifts
Brakes
How to install new brake shoes

With the above example you could also have a procedure titled, Testing to See
If You Need New Brake Shoes, or Rebuilding the Master Cylinder. As you can
see this module could prove to be quite useful once procedures have been
entered into the database.

Creating Procedures
Before your employees can start accessing procedures, you first need to enter
them into the database. The following procedure or exercise will explain the
steps in entering a new procedure into the database.
To create a new procedure:








Move to the Creation Options group in the ribbon and click on the New
Group option.
Now type in the name of your group in the box provided. Examples
here could be Chillers, Forklifts, and Palletizers and so on.
Next we need to add a sub-group. Do this by first clicking on the
Group name from within the list located to the left of the screen.
Now move to the Creation Options group in the ribbon and click on the
New Sub-Group option
Enter the sub group name in the box provided. Examples here could be
Main Drive Motor or General Procedures.
Next we need to add the procedure itself. To do this first select the
Group from within the Tree list, and then the sub-group.
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Move to the Creation Options group in the ribbon and click on the New
Procedure option.



Type in the new procedure title in the box provided. Examples here
could be Troubleshooting the Main Motor, Replacing the Main Circuit
Board, or General Troubleshooting Procedures.
Move to the Document Type section and select one of the options
available here.
o Editor File – This type of document uses the internal word
processor for document creation.
o Link or Attachment – This type of document links itself to
almost any type of external document. This can be word
processor documents, pictures files, and a web-site and so on.
Click on the OK button.





LINK OR ATTACHMENTS



If you created a Link type document then you will be shown an Open
type dialog screen. Use this dialog to browse to where the document is
residing, selecting the file, and clicking on the Open button.
If you want to use a relative path, such as a link to a folder, or web site
for example, click on the Cancel button,
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Now enter the relative path in the space provided, and click on the OK
button.

INTERNAL DOCUMENTS




If you created an internal or Editor type document move to the list view
to the left of the screen and click on the Procedure title you’ve just
created.
Now either double click on this icon or click on the Procedure button
in the ribbon’s View/Edit group.
Now you should be placed into the Procedure editor where you can edit
your procedure. To find how to use the features of this word processor
please refer to the Word Processor chapter.

NOTE ABOUT ATTACHMENTS
Basically any type of document, or path that can be accessed by the Windows,
Start – Run option can be used as an attachment. Normally you just point to a
file, and when opened that file will open itself along with the appropriate
application. These can include, but not limited to pictures, CAD drawings,
documents, web-sites and more.
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Viewing Procedures

To view or edit a stored procedure:





From the Procedures main screen move to the Tree View located to the
left of your screen and then click on appropriate group name.
Move to and click on the sub-group of your choice from under this
group.
Move to the Procedures List and click on the procedure title of your
choice.
Click on the Procedure option in the View/Edit group of the ribbon.
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Deleting Procedures

To delete procedures from within the database:



Select the procedure you wish to remove from the database from those
listed in the Procedures list.
Move to the Removal group in the ribbon and select the Delete
Procedure option.

Deleting Sub-Groups
To delete a sub-group category:




Before a sub-group can be deleted all procedures assigned to that subgroup must first be deleted. Please refer to the Deleting Procedures
section for the proper method on doing this.
Next select the sub-group that you wish to remove from the database
from within the Tree View list.
Move to the Removal group in the ribbon and select the Delete SubGroup option.

Deleting Groups
To delete a group:





Delete all Procedures associated with the desired Group.
Delete all Sub-Groups associated with the Group.
Select the Group title from those found in the Tree View list.
Move to the Removal group in the ribbon and select the Delete Group
option.
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Using the Procedures Editor
The editor used for the procedures is actually a small word processor, and
contains many of the features of commercial word processing programs. To
find how to use the features of this word processor please refer to the Word
Processor chapter.
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Overview
We are aware that many organizations require certain Forms and Permits to be
used in their day-to-day operations. We have included what we would consider
the most popular of these documents with this module. We also know that
many of you may have other requirements, and for this reason we give you the
ability to create your own Forms and Permits.

The forms included with this module were created using this module, and
should give you a pretty good idea of what can be done. This module uses a
spreadsheet type control as its base. The cells of this control can be setup to
use different cell types, which makes it ideal for creating forms. Cells can be
set as normal text or edit cells, date cells with popup calendars, combo box
cells where you can setup choices, and picture cells where you can use bitmaps
and icons.
Besides the ability of setting up and using different cell types, you also have
many formatting options at the cell level. You can specify the fonts, fore and
back ground colors, text overflow, and more. So if your organization can use a
form tool, we are happy to be able to supply you with simple to use, yet
powerful tool.
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Understanding the Ribbon’s Home Tab
The following elements are found in the ribbon, reading left to right, top to
bottom:





























New Form – Clears the current document in preparation of creating a
new one.
Page Setup – Calls the Page Setup dialog.
Copy – Sets the selected cells to be copied.
Pastes – Pastes the information set for copy into new cells.
Delete – Deletes a cell’s contents.
Font Combo – Sets and displays selected font name or types.
Size Combo – Sets and displays selected font point sizes.
Bold – Sets and displays selected font text bold characteristics.
Italic – Sets and displays selected font text italic characteristics
Underline – Sets and displays selected text underline characteristics.
Font – Allows you to set various font characteristics.
Foreground Color – Specifies the foreground color of selected text.
Background Color – Specifies the background color of selected text.
Edit Cells – Set the selected cells as text or edit cells.
Combo Cells – Allows you to insert a combo or drop down list into the
selected cell.
Date Cells – Set the selected cells as Date Cells.
Picture Cells – Allows you to insert a picture into the selected cell.
Checkmark Cells – Allows to insert a checkbox into the selected cell.
Center – Makes the text in selected cells, center aligned.
Left Align – Makes the text in selected cells, left aligned.
Right Align – Makes the text in selected cells, right aligned.
Cell Overflow – Allows selected cells to overflow into adjacent cells.
Properties – Opens the Page / Document setup screen.
Cells Insert – Displays options of inserting a new row or column into
the document.
Cells Delete – Displays options of deleting rows or columns from the
document
Format Cells – Displays options for column width, row height, and
column header text.
Page Breaks – Allows adding and removing document page breaks.
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Cells Properties – Allows you to set various cell properties such as
borders, colors and more.

Creating a New Form
To clear the current document in preparation of creating a new one:



Click on the New Form option in the ribbon.
When prompted about proceeding, click the Yes button.

Setting the Page or Document Properties
To setup the page or document properties:







Click on the Page Setup option in the ribbon.
Move to the Margins section and setup the 4 page margins located here.
These margins are setup in inch values. Where .5 would be the same as
half an inch.
Move to the Print Orientation section and select how you want the
document printed, Landscape or Portrait modes.
Move to the Print Options section.
To have the program print only the portion of the document with data,
place a checkmark in the Print Only the Portion with Data checkbox.
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Leaving this unchecked will print the entire document regardless if the
cells contain any data or not.
To have the program print a border around the entire document, place a
checkmark in the Print Border field.
To have the program print the document in color, place a checkmark in
the Print in Color checkbox. Leaving this unchecked, the document
will be printed using gray scales.
Move to the Documents Settings section.
To protect cells that have been set as protected or locked, move to and
place a checkmark in the Protect Locked Cells checkbox.
To hide the grid lines within the document, move to and place a
checkmark in the Hide Grid Lines checkbox.
To hide the column headers within the document, move to and place a
checkmark in the Hide Column Headers checkbox.
To hide the row headers within the document, move to and place a
checkmark in the Hide Row Headers checkbox.
To specify the number of columns available in the document, move to
and change the amount in the Max. Columns field.
To specify the number of rows available in the document, move to and
change the amount in the Max. Rows field.
To see your changes without closing this screen, click the Apply button.
To apply your changes and at the same time close this screen, click the
Ok button.

Print Preview
To receive a print preview of your document:




Click on the Module button then move over the Print option.
Click on the Print Preview option.
For more information on this print preview please refer to the Common
Features chapter.
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Print the Document
To print the document:



Click on the Module button then move over the Print option.
Click on the Print Document option.

Opening a Saved Form or Permit
To open a saved document:



Click on the Module button and select the Open option.
Use the File Open dialog to locate the file, and select it. Click Open.

Saving a Document
To save a form or permit:




Click on the Module button and select the Save option.
Move to the Save as File Type list box and select how you want the file
saved. Available options here are the default style or SS, Excel 5 style
or XLS, HTM or Internet documents, or tab delimited text files or TXT.
Move to the directory you want to save your file to, type in the file
name, and click Save.

Exiting this Module
To exit this module:


Click on the Module button and select the Close Forms and Permits
option.
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Selecting Cells to be Copied
This application does not copy cells into the clipboard, but rather marks cells
to be copied. When a paste operation is used, a copy of the marked cells is
copied into the new cells.
To copy cells:



Select the cells that will be affected.
Click on the Copy option in the ribbon. These cells will then be set for
a paste operation, and will remain set until a new range has been
selected.

Pasting Cells
To paste cells that has been marked.



Select the cell or cells you want to paste to.
Click on the Paste option in the ribbon.

Clearing Cells
To clear a cell or range of cells of all contents and formatting:



Select the cell or cells to be affected.
Click on the Delete option in the ribbon.

Setting Cells Width
To change the width of a cell or cells:
Method One
 With the column headers showing, place your mouse over the header
where it separates two columns, and the mouse cursor changes to
resizing handles (double lines and two sided arrows).
 Left mouse click and hold the mouse button down, at the same time
moving the mouse in the direction you want the cell to grow or shrink.
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Method Two





Select the column or columns you want to resize.
Click on the Format Cells option in the ribbon followed by the Set
Cell(s) Width option.
Types in your new value in the space provided and click the Ok button.

Setting a Row’s Height
To change the height of a cell or cells:
Method One
 With the row headers showing, place your mouse over the header
where it separates two rows, and the mouse cursor changes to resizing
handles (double lines and two sided arrows).
 Left mouse click and hold the mouse button down, at the same time
moving the mouse in the direction you want the cell to grow or shrink.
Method Two
 Select the row or rows you want to resize.
 Click on the Format Cells option in the ribbon followed by the Set
Row(s) Height option.
 Types in your new value in the space provided and click the Ok button.

Inserting a New Column
To insert a new column in your document:



Select the column just to the right of where you want the insertion to
occur by clicking in a cell.
Click on the Insert button in the ribbon followed by Insert Column to
the Left option, and a new column will be inserted for you.
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Inserting a New Row
To insert a new row in your document:



Select the row just below where you want the insertion to occur by
clicking in a cell.
Open the Format menu and select the Insert Row Above option and a
new row will be inserted for you.

Deleting a Column
To delete a column from your document:



Select the column you want to delete by clicking in any cell in that
column.
Open the Format menu and select the Delete Column option.

Deleting a Row
To delete a row in your document:



Select the row you want to delete by clicking in a cell belonging to the
row.
Open the Format menu and select the Delete Row option.

Inserting a Row Page Break
To insert a page break into your document:



Select the row you want to insert a page break into by clicking any of
the cells belonging to that row.
Click on the Page Breaks icon in the ribbon followed by the Insert
Page Break option.
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Clear All Page Breaks
To clear all page breaks in your document:


Click on the Page Breaks icon in the ribbon followed by the Clear All
Breaks option.

Renaming a Column Header
To rename a column header:




Select any cell within the column you want to rename by clicking on it.
Click on the Format Cells icon in the ribbon followed by the Rename
Column Header option.
Type in the new header information in the space provided, click the Ok
button.

Changing a Cell’s Properties
To change the properties of a cell or a group of cells:
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Select the cell or cells you want to work with.
Click on the Cell Properties option in the ribbon.
Move to the Border section and setup the border you want to apply to
the selected cell(s). The options are:
None – Removes any border properties currently assigned to the cell(s).
Left – Places a border to the left side of the selected cell(s).
Right - Places a border to the right side of the selected cell(s).
Top - Places a border to the top of the selected cell(s).
Bottom - Places a border to the bottom of the selected cell(s).
Outline – Places a border along the outside edge of all selected cells.
Move to Border Type drop down box and select the type of Border you
want to use by clicking on an option found there.
To specify the color of the borders, move to and click on the Set Color
button. Select the color of your choice by clicking on it, and then click
the Ok button.
Move to the Cell Colors section.
To set the background color of the selected cells move to the
Background field and click the Set Color button.
Select the color of your choice by clicking on it, and then click the Ok
button.
Repeat the above two steps for the foreground or font color.
To allow the application to use these colors, place a checkmark in the
Use Above Colors checkbox.
To allow Text overflow into adjacent fields, place a checkmark in the
Allow Text Overflow checkbox.
Click the Ok button.

NOTE ABOUT TEXT OVERFLOW
When applied text overflow applies to the whole document, not just a single
cell. If a cell is aligned as left aligned, text will overflow into the left adjacent
cell or cells. If it’s set as right aligned, text will overflow to the right. If a cell’s
text alignment is set as center aligned, text will overflow to adjacent cells in
both directions.

Edit Cell Text
You can edit the contents of a text cell directly on the form, or you can call up
an edit screen to help you do this. For long text we recommend the use of the
Edit Cell Editor.
To open and use the edit cell editor:
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Click on the Edit Cell icon in the ribbon, or click on the hot key
assignment of the Ctrl key and the T key at the same time.
Type or edit the cell’s text in the space provided.
Click the Accept button.

Font Characteristics
To setup the Font characteristics:





Select the cell or cells you want the formatting to effect.
Open the Cells menu and select the Characters (Font) option.
Setup the Font to use and the other characteristics to your liking.
Click the Ok button.

Setting the Cell Types
To specify a cell type:



Select the cell you want to work with by clicking it.
Open the Cells menu. Select the Cell Types option and then select the
type of cell you want to use. The following cell types are available:
o Date Cell – Set the cell as a date cell, where the user can select
a new date from a popup calendar.
o Edit (Text) Cell – This is the default type cell, and would be
used for text entry.
o Combo Box Cell – This is a drop down list box, where the user
can select from a list of items that you setup.
o Picture Box Cell – This allows you to supply a picture in the
cell.

Using a Date Type Cell
Once set, you can change the date of a date cell by:
Method One
 Clicking in that cell.
 Clicking the various parts of the date, and then clicking on the little
scroll keys to change the date.
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Method Two
 Double clicking in that cell to bring up a calendar.
 Select a date from within this calendar by clicking on it.
 Click the Ok button.

Using an Edit (Text) Cell
Once setup, you can change the text in an edit cell by:



Typing directly in the cell or by first clicking on that cell, then clicking
on the Edit Cell icon in the toolbar.
Edit the text in the box provided and then click on the Accept command
button.

Using the Combo Box Cell
Once setup, you can add list item to the combo box by:








Clicking the combo box cell to select it, then move to the toolbar and
click on the Combo Box icon.
Click the Add button to add items to the list. Typing in the item in the
space provided and then clicking the Ok button.
Repeat the above step for every item you want to include.
To remove an item, click on the item from within the list to select it.
Move to and click on the Delete button.
Once you’re done setting up the contents of the combo box, move to
and click on the OK button.
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Picture Cells
When you setup a picture cell you will be given the chance to assign that cell a
picture. These cells support bitmaps (bmp) and icon (ico) type images.
To set or change the image of a picture cell:





Click on the cell you want to work with.
Move to the toolbar and click on the Picture Cell icon.
Locate the image you want to use with this File Open type dialog.
Click the Open button.

Accessing the Built-in Forms
There are four built in forms that you can use. These include a Hot Work
Permit, Confined Space Permit, Hazardous Materials Form and an Accident
Report Form.
To access and load the built-in reports:


Open the Forms menu and select the form of your choice by clicking
on that option.

Maintenance Coordinator  Simplicity Software Technologies Inc.

16

MAINTENANCE COORDINATOR SYSTEM

Reports and Presentation Graphics

Maintenance Coordinator  Simplicity Software Technologies Inc.

2

Reports and Presentation Graphics
Table of Contents
Table of Contents ................................................................................................................ 3
Overview ............................................................................................................................. 4
Navigating between the Screens ......................................................................................... 5
Understanding the Report Writer’s Ribbon ........................................................................ 6
Creating a New Report........................................................................................................ 6
Joining Tables ................................................................................................................... 11
Report Page Setup ............................................................................................................. 12
Print Preview..................................................................................................................... 13
Printing the Reports .......................................................................................................... 13
Opening a Saved Report Setup ......................................................................................... 13
Saving a Report Setup ....................................................................................................... 14
Opening a Saved Report Document .................................................................................. 14
Saving a Report Document ............................................................................................... 14
Changing a Cell’s Properties ............................................................................................ 15
Font Characteristics .......................................................................................................... 16
Renaming a Column Header ............................................................................................. 16
Aligning Text .................................................................................................................... 17
Creating a Chart from Report Data ................................................................................... 17
Charts and Graphics .......................................................................................................... 18
Documents Feature ........................................................................................................... 19
Word Processor ................................................................................................................. 20

Maintenance Coordinator  Simplicity Software Technologies Inc.

3

Reports and Presentation Graphics

Overview
This module could actually be considered as four modules in one. The first
would be the Report Writer. This feature allows you to open an Access
database, select a table from that database, select fields from that table, and
setup sorting and selection criteria, and then generate a report. This report can
then be even further customized with fonts, colors and more. This feature was
added to allow users to create their own ad-hoc reports, as I’m sure someone
would like a report or two we didn’t include.

The second part of this module contains a Presentation Graphics designer.
This control was supplied to us by and outside vendor, and contains numerous
formatting options. You can select from 12 different 3D type charts, and 14
different 2D types. Each chart type then has their own styles associated with
them and more. This feature rich control also uses a chart wizard, and most if
not all elements of a chart can be used defined. Many people compare this
control to the chart control in Excel, but I believe this one has many more
features.
The third part of this module is our Document Feature. With this feature you
can record and maintain an almost endless amount of editor styled, and picture
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styled documents. The editor used here is Microsoft Word compatible and
contains many formatting features. This Document Feature is also 100 percent
compatible with the one found in our PM Coordinator application.
The last or fourth module would be the Word Processor. Here you use the
same word processor and in the Document Feature, but the documents are not
stored to a database. You would use this editor as with most editors, saving the
documents to file.
Note: Excel and Word are registered trademarks of the Microsoft Corporation.

Navigating between the Screens
To move from screen to screen, just click the
appropriate button in the shortcut bar located
on the left hand side of the screen or open the
Go menu and select the appropriate option.
The following options are on this shortcut
bar, reading top to bottom:





Report Writer- Clicking this button moves you to the Report Writer
screen
Charts / Graphics – Clicking this button moves you to the Presentation
Graphics designer.
Documents – Clicking this button moves you to the Document screen.
Word Processor – This is a stand alone work processor for the creation
and reading of rich text documents.
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Understanding the Report Writer’s Ribbon
The following elements are found on the ribbon reading left to right, up to
down:
















New Report - Calls the Report Creation Wizard in preparation of
creating a new report.
Report Properties – Opens the report properties dialog screen.
Font Combo – Sets and displays selected font name or types.
Size Combo – Sets and displays selected font point sizes.
Font – Allows you to set various font characteristics.
Rename Header – Allows you to rename the header information of the
selected column.
Foreground Color – Specifies the foreground color of selected text.
Background Color – Specifies the background color of selected text.
Format Cells – Allows you to setup cell properties, such as borders and
colors.
Left Align – Set selected text as left aligned.
Right Align – Set selected text as right aligned.
Center Align – Set selected text as centered aligned.
Create Chart – Allows you to create a chart or graphic from selected
cells.
Close – Exits this screen.

Creating a New Report
To create a new report:




Open the Go menu and select the Report Writer option.
Click on the New Report icon in the ribbon
From the Database tab, click on the Database Connection button.
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From the Data Link Properties dialog, move to the Provider tab by
clicking on it.
From the list click on Microsoft Jet 4.0 OLE DB Provider option.
Click the Next button.

Click on the … button adjacent to the Select or enter a database name
text box.
Use this file open type dialog to select the database that you want to
base your report on. Click Open.
Click either Next or the Select Table tab.
The drop down list here will contain all tables found within the selected
database. Move to this list and select the table you want to base your
report on by clicking on it.
Click either the Next button or the Select Fields tab.
All the database fields from the selected table will be displayed on the
left. You now need to select the fields to include in your report.
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To select one field at a time, move to the list and click on the field
title of your choice, next move to and click on the > button to
move the field to the right list. Double clicking on a field will also
move it to the right list.
To move all the fields to the right list (Selected Fields), and have
them all included in the list, click on the >> button.
To remove selected fields from the report, reverse the selection
process using the < and << buttons.
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Click either Next or the Report Criteria tab. Information setup on this tab
is optional.
Move to the top most Database Fields drop down and select a field to use
as a selection filter.
Move to the Operator drop down and select an operator to use with the
selection criteria you are setting up.
Move to the Matching Data field and setup the filtering criteria. Sample
data is included in the drop down list. If the field is a date field, you can
select a date by clicking on the … button adjacent to that field.
If you want, you can repeat the above 3 steps for the remaining 3 setups.
Click either Next or the Sort By tab.
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Move to the top most drop down and select a field in which to sort your
report by. If you want the report to be sorted in descending order place a
checkmark in the Descending Order checkbox. No checkmark, ascending
is assumed.
If you want you can repeat the above step for total of three fields to sort
the report by.
Click Finish.
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Joining Tables
In many times you may want to report on information from more than one
table within the database. To do this you will need to join tables, and setup
matching criteria to do this. The procedure for using two tables in your report
will be outlined next.










Start the creation of your report as outlined in the previous section.
After selecting your database click the Select Table tab.
The drop down list here will contain all tables found within the selected
database. Move to this list and select the table you want to base your
report on by clicking on it.
Click and check the Select and Join Second Table checkbox
Move to the second table drop down list, and select the second table.
Move to the Joining Tables – Fields Matching Criteria and setup the
criteria for joining these tables. These fields will normally have the
same field name, and be of the same data types as shown in the
example.
Finish the report setup process as previously outlined.
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Report Page Setup
You can setup the print orientation, page margins, and report color using the
Report Page Setup option.

To use the report page setup:











Click on the Report Properties icon in the Settings group of the ribbon.
To change or edit the reports title, move to the Report Title text box and
edit the information found there.
To specify the page margins to use move the Margins area as type in
your new values. The margins are setup in inch values, where .5 would
be the same as ½ inch.
To specify the orientation of the printed document, move to the Print
Orientation section and select the option of your choice.
To specify the background color for even rows within your report,
move to and click on the Even Background button.
Select the color of your choice from the color picker dialog and then
click the OK button.
Repeat the above two steps for the other colors.
To actually use the specified colors, ensure there is a checkmark placed
in the Use Above Colors checkbox.
To apply your changes without closing the screen, click on the Apply
button.
To apply your change and exit this screen, click on the OK button.
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Print Preview
To obtain a print preview of the current report:



Click on the Module button in the ribbon.
Move over the Print option and then click on the Print Preview option.

Printing the Reports
To print the current report:




Click on the Module button in the ribbon.
Move over the Print option and then click on the Print Record option.
When the Print dialog appears, click on the Print button.

Opening a Saved Report Setup
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To open a saved setup:





Click on the Module button in the ribbon.
Move over the Save button and select the Save Report Setup option.
Use the File Open dialog to locate the file, and select it. Click Open.
Edit the report setup to your liking, clicking the Finish button when
done.

Saving a Report Setup
You can save a report setup to file, thereby eliminating the need to recreate
everything from scratch. Once re-opened, you will only need to change some
of the report criteria to you new specifications.
To save a report:




Click on the Module button in the ribbon.
Move over the Open button and select the Open Report Setup option.
Move to the directory you want to save your file to, type in the file
name, and click Save.

Opening a Saved Report Document
To open a saved document:




Click on the Module button in the ribbon.
Move over the Open button and select the Open Document option.
Use the File Open dialog to locate the file, and select it. Click Open.

Saving a Report Document
To save a report:




Click on the Module button in the ribbon.
Move over the Save button and select the Save Document option.
Move to the Save as File Type list box and select how you want the file
saved. Available options here are the default style or SS, Excel 5 style
or XLS, HTM or Internet documents, or tab delimited text files or TXT.
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Move to the directory you want to save your file to, type in the file
name, and click Save.

Changing a Cell’s Properties
To change the properties of a cell or a group of cells:







Select the cell or cells you want to work with.
Click on the Format Cells option in the ribbon.
Move to the Border section and setup the border you want to apply to
the selected cell(s). The options are:
o None – Removes any border properties currently assigned to the
cell(s).
o Left – Places a border to the left side of the selected cell(s).
o Right - Places a border to the left right of the selected cell(s).
o Top - Places a border to the top of the selected cell(s).
o Bottom - Places a border to the bottom of the selected cell(s).
o Outline – Places a border along the outside edge of all selected
cells.
Move to Border Type drop down box and select the type of Border you
want to use by clicking on an option found there.
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To specify the color of the borders, move to and click on the Set Color
button. Select the color of your choice by clicking on it, and then click
the Ok button.
Move to the Cell Colors section.
To set the background color of the selected cells, move to the
Background field and click the Set Color button.
Select the color of your choice by clicking on it, and then click the Ok
button.
Repeat the above two steps for the foreground or font color.
To allow the application to use these colors, place a checkmark in the
Use Above Colors checkbox.
To allow Text overflow into adjacent fields, place a checkmark in the
Allow Text Overflow checkbox.
Click the Ok button.

NOTE ABOUT TEXT OVERFLOW
When set, text overflow applies to the whole document, and not just to a single
cell. If a cell is aligned as left aligned, text will overflow into the left adjacent
cell or cells. If it’s set as right aligned, text will overflow to the right. If a cell’s
text alignment is set as center aligned, text will overflow to adjacent cells in
both directions.

Font Characteristics
To setup the Font characteristics:





Select the cell or cells you want the formatting to effect.
Move to the Font group in the ribbon and select the Format Fonts icon.
Setup the Font to use and the other characteristics to your liking.
Click the Ok button.

Renaming a Column Header
To rename a column header:




Select any cell within the column you want to rename by clicking in it.
Move to the Font group in the ribbon and select the Rename Header
icon.
Type in the new header information in the space provided, click the Ok
button.
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Aligning Text
To change the alignment of text with a cell or cells of your report:



Select the cell or cells you want to work with.
Move to the Cell Formatting group and select the option of your
choice. Available options include: left, right and center align.

Creating a Chart from Report Data
You can create charts and graphs directly from report data, to use this feature:


Create your report as outlined previously in this chapter. Try to select
you report fields so that one column will hold the labels for your chart,
and the next adjacent field(s) contain report numeric data.



Select the rows and columns that you want to create a chart on from
within the report grid.
Click on the Create Chart option in the ribbon.
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Charts and Graphics
Another section of the reports module is the Charts and Graphics feature, and
with this feature you can create some pretty outstanding charts and
presentation styled graphics. This designer is also used by some of our reports,
and for this reason we only discuss it once in the Common Features chapter.
Please refer to this chapter for details on using this feature. Also explore the
help file for even more insight on all the options available to the feature.

To access the chart and graphics designer:


Click on the Graphics option in the shortcut bar.

To access most features of this designer:


Right mouse click on the element of the chart you want to work with.
This can include the chart itself, or any of its elements.
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Documents Feature
Yet another section of the Reports module is the Documents feature. Here we
provide you with a means to record and maintain a countless number of
different documents that are grouped by categories. These documents can
either be word processor type documents, images, or links to external files.

This feature is used in various places throughout the Maintenance Coordinator
system, and the one here is completely compatible with the same feature found
in our PM Coordinator application. For more information on using this feature,
please refer to the chapter titled: Common Features.
To access the Documents feature:


Click on the Documents option in the shortcut bar.
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Word Processor
We use the built in word processor all over the Maintenance Coordinator
system and you should learn how to use it quite well. For this reason we have
decided to allow you to use this powerful feature all by itself. Create and read
documents with this feature rich text editor.
For more information on how to use this word processor please refer to the
Word Processor chapter.

To access the word processor:


Click on the Word Processor option in the shortcut bar.
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Overview
We know that many times you’ll find that the person responsible for
maintenance is often responsible to over see safety performance as well. With
the Safety Management module we give you the tools to track accidents, do
complete investigations on incidents, and make analyzes of incidents to
prevent further occurrences, and more.

This module also allows you to track workmen compensation claims and costs,
create and track safety inspections and create a safety punch list. It’s also an
easy task to turn incidents or punch list items into work orders. These work
orders can also be tracked from within this module. So if you need safety
management in your workplace, this module should provide you with the
resources to get the job done.
This module is basically made up of four different internal modules or
sections. You have Accidents, Workers Compensation, Safety Inspections and
a Punch list section. Our discussion on this module will be broken down into
these sections.
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Moving Around in the Module
This module is divided into sections. To
move from one section to another:



Open the Go menu and make
your selection or click on a
choice in the shortcut bar.

O

Accidents and Incidents
The Accident and Incidents section is where you can track incidents in your
workplace, and analyze these incidents with the built in reports. By analyzing
this information problem areas can be identified and corrective action can be
taken. Accidents can cost a company a lot of money as employees miss work,
payment of workers compensation costs, and property damage.
One area this section shines is in record keeping. You can keep detailed record
on every incident within the database, and the documents can also be printed to
provide for hard copy type records. The advantage of keeping the incidents in a
database, as opposed to just hard copies, is that the information can be more
readily analyzed and reported on

Accidents Lookup View
The Lookup View tab acts much like a lookup table. Here you simply click on
the incident of your choice to select it. Once selected you can move to the
other tabs to view or edit it.

Resorting the Accidents Database
To resort the Accidents database:


Move to the Accidents section by accessing the Go menu and selecting
the Accident Reports option.
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Move to the Table View tab.
Select a sort option from the Sort By drop down list. The database will
be sorted by whatever field you selected from this list.

Creating a New Incident / Accident Record
This is the main incident investigation report that would be filled out from
interviews with the main parties involved, and any witnesses you may have.
Depending on how your operation is setup, the information would be recorded
by your safety team, or perhaps the immediate supervisor.
To create a new incident report:







Gather all the necessary information needed.
Move to the Accidents section by accessing the Go menu and selecting the
Accident Reports option.
From the Home tab of the ribbon, click the Add New Record option.
Move to and click on the General tab.
Move to the various fields found on this screen and input the appropriate
information.
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Repeat the above step for the Details – Medical, Causes, Action – Review,
and Investigation tabs.
Click on the Post/Save Changes icon in the ribbon to save your
information.

Root Cause Field
The Root Cause field of the Incident document is somewhat different from the
remainder of the fields. This field does not show up on any of the printed
documents but is used exclusively for reporting. This field let’s you group like
incidents on reports, and you should try to reuse the same description as often
as possible. Good descriptions for this field maybe ducking under, machine
malfunctions, running, horseplay, and so on. Hopefully, you can see how this
may come in handy for grouping like causes on reports.
To set the root cause field:





Create your incident reports as previous stated.

Move to the Causes tab by clicking on it.

Move to and click on the … button adjacent to the Root Cause
field.
Use the dialog as would use the Quick Entry dialog explained in the
Common Features chapter.
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Associate Report
This report is the facts of the incident as described by the employee or
employees involved. You can create more than one Associate report per main
incident.

To create an Associate Report:








First create and the select the Main Accident / Incident record this
document will be associated with.
Click on the Injured Report in the ribbon.
Click on the Add New Record button in the ribbon.
Move to and click on the Facts – Job Steps tab.
Move to the various fields found on this screen and input the appropriate
information.
Repeat the above step for the Causes, and Prevention – Associate tabs.
The information entered will be saved for you automatically.
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Witness Report
Any witness you have to an incident or accident should fill out this report. You
can create as many witness reports as you would like

To create a Witness Report:








First create and the select the Main Accident / Incident record this report
will be associated with.
Select the Witness Report option in the ribbon.
Click on the Add New Record button.
Move to and click on the General tab.
Move to the various fields found on this screen and input the appropriate
information.
Repeat the above step for the What Happened, and Witness tabs.
The information entered will be saved for you automatically.
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Delete an Accident Record
To delete an Accident Record, including all Associate (Injured) and Witness
reports attached to that incident:



Locate and select the Accident / Incident report that you want to delete.
Click on the Delete Record option in the ribbon.

Delete an Associate Report
To delete an Associate report record:





Locate and select the Accident / Incident report that’s associated with the
report you want to delete.
Select the Injured Report option in the ribbon.
Use the data control and display the report you want to delete.
Click on the Delete Record button in the ribbon.

Delete a Witness Report
To delete a Witness report record:





Locate and select the Accident / Incident report that’s associated with the
report you want to delete.
Select the Witness Report option in the ribbon.
Use the data control and display the report you want to delete.
Click on the Delete Record button in the ribbon.

Printing an Investigation Report
To print one of the investigation reports:



Locate and select the document that you want to print.
Click on the Print Record option in the ribbon.
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Printing Blank Investigation Forms
To assist you in gathering information on incidents, we have included blank
investigation forms that can be printed. Once printed, these forms can be filled
out and then later transferred to the database.
To print a blank investigation form:



Click on the Reports tab in the ribbon and move to the Blank Investigation
Forms section.
Select the investigation form of your choice.

Creating a Work Order from an Incident
Many accidents and incidents result in some form of corrective action to be
done to prevent further incidents. For this very reason we have provided the
means to create a work order from an incident. The resulting work order will
be available in the work orders module, awaiting assignment and completion.
To create an Incident work orders:
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Locate and select the incident that you want to create a work order for from
within the Accidents section.
Click on the Create W.O. option in the ribbon.
When asked if you want to create a work order, click Yes.
Move to the Work Order Types area and click on the option here that best
describes the type of work order you’re creating.
Move to and click on the … button adjacent to the Equipment or Machine
field. Select the name of the equipment you want to assign to this work
order from within the grid.
Click the Select button.
Move to the other fields and enter the appropriate information.
When you’re done with this tab, click the Next button to move to the next.
Edit the fields on the Work to Perform tab to your liking.
Click the Save and Close button in the ribbon.

Accident Report Wizard
With the Accident Report Wizard you can start analyzing your incident
information to help understand it better. With the knowledge you gain, you can
begin your prevention strategies.
To create a report using the Accident Report Wizard:
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From the Accidents section, click the Reports tab and select the Report
Wizard option.
Move to the Accident Types drop down and select the type of incident you
want to base your report on. To use all types, place a checkmark in the Use
All Types checkbox.
Repeat the above step for the Accident Treatment and Work Status sections.
Move to Date Range section and click on the … buttons adjacent to the
Start Date and End Date fields and select the appropriate dates from the
pop up calendar.
To use all dates, place a checkmark in the Use All Dates check box.
Move to the Group By drop down, and select how you want to group your
report.
Click the Select button.
When the chart loads, you can format this chart to your liking. Please refer
to the Chart Designer chapter for more information.
Click the Close button.

Accident Report by Fields
This report allows you to breakdown incidents by individual fields. This helps
you gain much insight to what’s happening in your work place.
To create an Accident Report by Fields report:



From the Accidents section, click the Reports tab and select the Accident
Field option.
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Move to the Database Fields Available and select the field you want to
base your report on.
Click the next button.
Move to and click on the … buttons adjacent to the Start Date and End
Date fields and select the appropriate dates from the pop up calendar.
Click the Finish button.
When the chart loads, you can format this chart to your liking. Please refer
to the Chart Designer chapter for more information.
Click the Close button.

Creating a Workers Compensation Claim
With the Safety Module you can keep a summary of Workers Compensation
Claims as they relate to your Accident Reports, in fact each accident record
can have a Workers Compensation Summary attached to it.
To create a Workers compensation claim:





Locate and select the incident that you want to create a claim on, from
within the Accidents section.
Select the Workers Compensation option in the ribbon.
When asked if you want to create a claim, click Yes.

More information on the Workers Compensation form will be explained in the
Workers Compensation section of this chapter.
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Workers Compensation Section
The Workers Compensation section allows for the quick lookup, and editing of
workers compensations claims and documents. Claims are created from
Accidents and Incidents.

Resorting the Workers Compensation Database
To resort the database:



Move to the Workers Compensation section by clicking on the Workers
Compensation option in the shortcut bar.
Select a sort option from the Sort By drop down list. The database will
be sorted by whatever option you have selected from this list.
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Using the Workers Compensation Form / Editor
With the Safety Module you can keep a summary of Workers Compensation
Claims as they relate to your Accident Reports, in fact each accident record
can have a Workers Compensation Summary attached to it.

The top section of the Workers Compensation dialog screen contains summary
information from the accident report. The second section allows you to keep a
complete history of your payments.
The third section contains Claim Summary information such as the Claim
number, Date claim closed, and the dollar amount associated with the claim.
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The lower section is a notes section for this claim. This note section can
contain any information that you feel relates to this specific claim. You can put
around three pages of text in this notes section, or 32,000 characters.
To add or view information on the Workers Compensation for an incident:





Display the related accident / incident report within the Accident section.
Select the Workers Comp option in the ribbon.
Move to the various text fields and add or edit the information as you see
fit.
Click on the Close button to exit this screen when ready, any changes you
have made will be automatically saved.

To add information into the Payment History section:



Move to and click the Add New button.
Click in the various fields of the grid and type in your information.

To remove information from within the Payment History section:



Move and click within the row that contains the information you wish to
remove.
Move to and click on the Delete button.

NOTE: You can edit the contents of the payment history at any time by double
clicking within a grid cell, and typing or editing its contents.
To print the claim:


Move to and click on the Print option in the ribbon.

To Edit a Workers Compensation Claim





Move to and click on the Workers Compensation button in the shortcut bar.
Select the claim you want to edit from within the grid.
Click the Edit Claim button in the ribbon.
Refer to the Using the Workers Compensation Form / Editor.
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To Print a Workers Compensation Claim




Move to and click on the Workers Compensation button in the shortcut bar.
Select the claim you want to print from within the grid.
Click the Preview button in the ribbon.

To Delete a Workers Compensation Claim




Move to and click on the Workers Compensation button in the main
toolbar.
Select the claim you want to delete from within the grid.
Click on the Module button and select the Delete Claim option.

Workers Compensation Report
To create a Workers Compensation Report.






Move to and click on the Workers Compensation button in the shortcut bar.
Click on the Claims Report option in the ribbon.
Move to and click on the … buttons adjacent to the Start Date and End
Date fields and select the appropriate dates from the pop up calendar.
Click the Accept button.
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Safety Inspections
As you know regular safety inspections are essential in keeping your plant
safe, clean, and in compliance with various regulations. With the safety
inspections feature it’s an easy task to create and administer regular safety
inspections. This feature incorporates its own scheduler, in which to
automatically generate future inspections.

Inspections Lookup View
The Lookup View tab acts much like a lookup table. Here you simply click on
the inspection of your choice to select it. Once selected you can move to the
other tabs to view or edit it.
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Resorting the Inspections Database

To resort the Inspections database:






Move to the Inspections section by clicking on the Inspections option
in the shortcut bar.
Move to the Lookup View tab.
Select a sort option from the Sort By drop down list.
Repeat the above step for the Status drop down.
Click the Refresh Now button.

Creating Inspections Checklists
Before you can create inspection documents, you need to create the actual
inspection checklists. These are the lists that the inspectors will be working
from, and allow these lists to be arranged in groups.
To create an Inspection checklist:
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Move to the Inspections section by clicking on the Inspections option in the
shortcut bar.
Click on the Edit Inspection option in the ribbon’s Lists group.
Click on the Module button and select the Add New option.
Type in a title for your new inspection in the space provided. Click OK.
Click on the inspection title you just created from within the grid.
Click Select.
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Move to and click on Add Group. Types in a group name in the space
provided and then click the OK button. This group title could be an area
that needs inspection. Examples here could be electrical room, break room,
main production area, and so on.
Repeat the above step for all the groups you want to setup.
Now you need to include inspection items for each of your groups. Select
the group you want to add inspection items to.
Click the Add Item button.
Types in the inspection item or task in the space provided and then click
OK. Example here could be, check for missing guards and covers, check
for trip hazards, check for open electrical cabinets, and so on.
Repeat the above step for all items you want to add to a group, and then
repeat it for all the groups you want to set up.
Click the Close button when done.
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Editing Inspection Checklists
To edit an inspection checklist, adding or removing items:






Move to the Inspections section by clicking on the Inspections option in the
shortcut bar.
Click on the Edit Inspection option in the ribbon’s Lists group.
Click on the inspection title you want to edit from within the grid.
Click Select.
Edit the list in the same fashion it was created.

To edit the title of an inspection group or item:




Double click on the item you wish to edit.
Modify or type in the new description in the space provided, and click OK.

Deleting items:



Select the item you want to delete
Move to and click on the appropriate Delete button for the group or item
you want to remove.
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Creating New Inspections
To create a new inspection:











Move to the Inspections section by opening the Go menu and selecting the
Safety Inspections option.
Click on the Add New Record option in the ribbon.
Click on the Details View tab.
Move to the Inspection Description field and type in a description for this
inspection.
Move to the Recurring Setup area and select how often you want the
inspection to repeat itself by selecting an option from the Frequency drop
down list.
Move to the Every XX Criteria text box and type if the number that
represents the interval to repeat this inspection. This works with
frequencies that have the XX criteria in their descriptions.
Move to the Inspection Status section and select the status you would like
to assign to this inspection.
Move to the Classification Assignment section and click on the … button
adjacent to this field.
Select a classification form within the list, and then click on the Select
button.
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Move to and click on the Select Inspection Tasks button.
Select the inspection instructions you want to assign to this inspection from
those listed in the grid.
Click on the Select command button.
Click on the Post/Save Changes option in the ribbon to ensure the
inspection is saved.

Completing an Inspection
Once an inspection has been completed, information about that inspection
should be recorded into the database.
To record inspection completion information:








Move to the Inspections section by opening the Go menu and selecting the
Safety Inspections option.
Locate the inspection record you want to record information.
Click on the Details View tab.
Move to the Inspection Status area and update the current status by making
a choice from the Current Status drop down.
Move to the Date of Inspection area and click on the … button. Select the
date of the inspection from the calendar, and click the Select button.
Move to the Inspected By area, and record the names of the people that
conducted the inspection.
Move to the Inspection Comments section and record any information
about the inspection that you would like to save. Such as any action items
that may need correction.

Delete Inspection
To delete an inspection record:




Move to the Inspections section by opening the Go menu and selecting the
Safety Inspections option.
Locate and select the inspection record you want to delete.
Choose the Delete Record option in the ribbon.
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Do Not Generate Inspection
The Do Not Generate Inspection flag prevents the program from generating
new inspections. The program itself places a checkmark right after a new
inspection has been created. This is done to prevent the program from
repeatedly generating the same inspection over and over again.
To toggle the Do Not Generate Inspection flag:


Click on the Module button and select the Change Do Not Generate Value
option.

Sort Options
Besides from the sort options available on the Table View tab, you have other
sort options found under the Sort menu. These become useful when you want
to see all the inspections in the database, or want to see all the inspections that
are set to regenerate themselves.
To use one of the above sort options:


Move to the Sorts/Filters group in the ribbon and select the sort option
of your choice.

Printing and Generating Inspections
With the Generate Tasks option you can setup and print a date range of
inspections. If the date range you specify contains inspections that have not
already been generated by the program, the program will generate then as this
routine is executed.
To generate a range of inspections to be printed, please follow these steps:
.
 Click on the Generate Inspections tab.
 Click on the Generate button.
 From the Select Task Dates screen, move to and click on the …
command button adjacent to the Start Date field.
 Select the Start Date range from within this calendar, and click Select
Date.
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Move to and click on the … command button adjacent to the End Date
field.
Select the ending date for your tasks date range from within this
calendar, and the click Select Date.
Click the OK command button and the program will generate all
inspections that fall within the date range you have just setup.

Now you have a couple of options in the printing of inspections. To
print all the inspections generated just move to and click on the Print
All command button.
To print selected inspections from the list, click on the inspections you
wish to print to select it, and then click the Preview command button.
From the Preview screen, click the Print command button to print the
document.
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Create a New Archive Database
As you continue to use this application, your database is sure to grow in size.
As a database grows too large there can be performance issues such as speed
issues, and problems with the data itself. For these reasons it is highly
recommended that you remove data from the database in regular intervals.
Either deleting older records or archiving them to an external database can do
this for you. In order to archive your records, you’ll first need to create an
archive database.
To create an archive database:




Click on the Module button and move over the Databases option.
Select Create Archive Database.
Use this Save As type dialog as would any found in Windows,
specifying the name and save path of this new database.
Click the Save command button.

Archiving your Database
To archive your database:




Click on the Module button and move over the Databases option.
Select Archive Database.
Move to the Date Range section and click on the … command button
adjacent to the Start Date field.
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Select the start date for your archive from within this calendar. Click on
the Select Date button.
Repeat the above step for the End Date field. All inspections that fall
between these two date ranges will be selected for archiving.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click the Archive button to remove the files from your main database,
and place them into the Archive database.

IMPORTANT NOTE: Archiving files free up valuable database space, but this
space will not be fully realized until you also perform a compact on the
database. Performing a compact will free up this valuable database space.
Please refer to the Database chapter for more details.

Restore Records from Archive
With the Database Restore feature you have two different restore options. You
can restore every record found in the archive database, or restore a date range
of records.
To restore all records from archive:






Click on the Module button and move over the Databases option.
Select Restore Database.
Move to the Restore Options section and click on the Restore All radio
button.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click Restore.

To restore a date range of records from archive:




Click on the Module button and move over the Databases option.
Select Restore Database.
Move to the Restore Options section and click on the Restore Dates
radio button.
Move to the Restore Date Ranges section and click on the … command
button adjacent to the Start Date field.
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Select the start date range for your restore from the calendar and click
on the Select Date button.
Repeat the above 2 steps for the End Date field to setup the ending date
of the restore range.
Move to the Archive Database path section and click the Browse
button.
Locate and select your archive database using this file open type dialog.
Click Open.
Click Restore.

Deleting a Date Range of Inspections
To permanently remove a date range of inspections from the database:




Click on the Module button and move over the Databases option.
Select Delete Date Range.
Select the ending date for this completion from the calendar, and click
the Select Date button. All inspections that fall on or before this date
will be permanently removed from the database.
Next you’ll be notified of how many records will be deleted, and given
your last chance to back out. To continue with the deletion, click the
Yes button. If you have changed your mind, click any of the other two
buttons.

Inspections Report
The Inspections report will provide you with a printed document on all your
safety inspections.

To create a Safety Inspection report:





Select the Inspection Report option in the ribbon.
Move to the Status section and select the status criteria to base your report
on. To ignore the status, and report on all inspections, place a checkmark in
the Use All checkbox found in this section.
Move to the Classifications section and click on the … button found here.
Select the classification assignment you want to base your report on from
those listed and click on the Select button.
To ignore classification assignments, place a checkmark in the Use All
checkbox found in the Classifications area.
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Move to the Date Range area and click on the … buttons adjacent to the
Start Date and End Date fields. Select the report dates from the pop up
calendar, and click the Select Date button.
To use all dates, place a checkmark in the Use All Dates checkbox.
Click on the OK button to create the report.

Safety Tasks - Punch List
Any good safety program is sure to generate a list of things that need attention.
These can come from the results of safety inspections, suggestions, and
accidents. The punch list allows you to keep track on these items and actually
create work orders form this list.
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Accessing the Safety Tasks List
To access the Punch List:


Click on the Safety Tasks button in the shortcut bar or open the Go menu
and select the Punch List option.

Adding a Task to the Punch List
To add a task:


Move to and click on the Add New button in the ribbon. This will insert
a blank task into the database, and at the same time pull up the task
editor.

Editing a Task
To edit a task, once it’s been created:
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Select the task you want to edit from within the grid.
Click on the Edit Task button in the ribbon.
Move to the various fields and edit them to your liking.
Click the Save and Close button in the ribbon.

Creating a Work Order from a Punch List Item
You may want to create work orders so the maintenance department can take
care of many of your punch list items.
To create a Punch List work order:






Locate and select the task item that you want to create a work order for
from within the Punch List section.
Click on the Edit Task button in the ribbon.
Click on the Work Order button in the ribbon.
Move to the Work Order Types area and click on the option here that best
describes the type of work order you’re creating.
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Move to and click on the … button adjacent to the Equipment or Machine
field. Select the name of the equipment you want to assign to this work
order from within the grid.
Click the Select button.
Move to the other fields and enter the appropriate information.
When you’re done with this tab, click the Next button to move to the next.
Edit the fields on the Work to Perform tab to your liking.
Click the Save and Close button.

Deleting a Task from the Punch List
To delete a task:



Select the task you wish to delete by clicking on it from within the
Punch List grid.
Move to and click on the Delete Task button in the ribbon.

Purging all Completed Tasks
To delete all completed tasks from the Punch List:



Open the Module menu and select the Purge Completed option.
When the Purge Records dialog appears, move to and click on the Yes
button.

Sorting the Punch List
You can have your Punch List sorted by either the tasks Dates or Priority
fields.
To sort the database by dates:


Move to and click on the Sort by Date option in the ribbon.

To sort the database by priority indicators:


Move to and click on the Sort by Priority option in the ribbon.
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Printing the Punch List
To print all open tasks within the Punch List:




Move to the Safety Tasks screen.
Move to and click on the Print List option in the ribbon.
Now move to and click on the Print button on the preview screen to
send the report to the default printer.

Maintenance Coordinator  Simplicity Software Technologies Inc.

36

MAINTENANCE COORDINATOR SYSTEM

Portable Computers

Maintenance Coordinator  Simplicity Software Technologies Inc.

2

Portable Computers

Maintenance Coordinator  Simplicity Software Technologies Inc.

3

Portable Computers
TABLE OF CONTENTS
TABLE OF CONTENTS ................................................................................................. 4
Portable Computers (Devices) Module ........................................................................... 6
Maintenance Coordinator Mobile ................................................................................... 6
Compatible Devices........................................................................................................... 8
Installing Maintenance Coordinator – Mobile ............................................................... 8
Desktop Software Not Supplied ....................................................................................... 9
Using the Portable Devices Module ............................................................................... 10
Completed Work Orders................................................................................................ 11
Auto Save to Equipment History ................................................................................... 11
Auto Update with Download .......................................................................................... 11
Install to Device Option .................................................................................................. 12
Create New Export Database......................................................................................... 12
Open or Set Sync Database ............................................................................................ 13
Save Current Sync Database ......................................................................................... 13
Setting Exports / Sync Options ...................................................................................... 14
Work Orders Export / Sync Options ............................................................................ 14
Work Order Parts and Labor Databases ..................................................................... 15
Equipment Export / Sync Options ................................................................................ 15
Mechanics Export / Sync Options ................................................................................. 16
Inventory Export / Sync Options ................................................................................... 16
Prepare Database for Device Download ....................................................................... 17
Update Main Database with Uploaded Changes ......................................................... 17
Maintenance Coordinator – Mobile .............................................................................. 18
Starting Maintenance Coordinator – Mobile ............................................................... 18
Navigating with Maintenance Coordinator – Mobile .................................................. 19
Work Orders (Lookup) .................................................................................................. 19
To move to the Work Orders lookup screen: ............................................................ 19
To open a Work Order for viewing or editing: ......................................................... 20
To locate a specific work order:................................................................................ 20
To show all work orders by the Default Sort: ........................................................... 20
To show all work orders (including those marked as completed): ........................... 20
To show all work orders assigned to a single piece of Equipment: .......................... 20
To view the Work Order Details:.............................................................................. 21
To Close the Work Order Lookup and Return to the Main Menu: ........................... 21
Adding new Work Orders ......................................................................................... 21
Purging Completed Work Orders ................................................................................. 21
Work Orders Details ...................................................................................................... 22
View or Edit Work Order Instructions ........................................................................ 23
To View a Work Order’s Safety Instructions .............................................................. 24
Work Order Parts ........................................................................................................... 24
To add or record parts used for work order completion: .......................................... 24
To add a part to the work order:................................................................................ 25
To edit the quantity needed or used: ......................................................................... 25
To delete a part from this work order: ...................................................................... 25

Maintenance Coordinator  Simplicity Software Technologies Inc.

4

Portable Computers
Work Order Labor ......................................................................................................... 25
To add or record labor used for work order completion: .......................................... 25
To add a mechanic to the work order: ...................................................................... 25
To edit the man hours needed or used: ..................................................................... 26
To delete a mechanic from this work order: ............................................................. 26
View or Edit Completion or Status Information ......................................................... 26
Work Orders Schedule ................................................................................................... 28
To move to the Work Orders Schedule module: ....................................................... 28
To open a work order for viewing or editing: ........................................................... 28
To locate a specific work order:................................................................................ 28
To change the dates of the Work Order Schedule: ................................................... 29
Equipment Database....................................................................................................... 29
To move to the Equipment Database: ....................................................................... 30
To open an Equipment record for viewing or editing: .............................................. 30
To locate a specific asset: ......................................................................................... 30
Equipment Details........................................................................................................... 30
Inventory Database ......................................................................................................... 31
To move to the Inventory Database: ......................................................................... 31
To open an Inventory record for viewing or editing: ................................................ 31
To locate a specific part: ........................................................................................... 32
Parts Details..................................................................................................................... 32
Mechanics Database ....................................................................................................... 33
PORTABLE DEVICES – ACCESS DATABASE SYNCHONIZATION ................. 34
Overview ................................................................................................................... 34
Accessing the Access Sync Routines .............................................................................. 34
Making a Database Replicable ...................................................................................... 35
Creating a New Replica Database ................................................................................. 35
Performing a Synchronization on Two Databases....................................................... 36
Setting the Master Database Path ................................................................................. 37
Saving Sync Settings ....................................................................................................... 37
Open Sync Settings ......................................................................................................... 38

Maintenance Coordinator  Simplicity Software Technologies Inc.

5

Portable Computers
Portable Computers (Devices) Module
The Portable Devices module provides support for devices you take out in the field with.
With it you can synchronize databases to Palm Devices, or any Windows compatible
laptop. However, with Database Synchronization routines you are not really limited to
only these devices. You can synchronize you database to database on portable devices,
stored on remote servers, or servers in the cloud.

Maintenance Coordinator Mobile
The Maintenance Coordinator – Mobile application is an extension of our normal
Maintenance Coordinator series of CMMS applications and is designed to allow
you to take a portion of Maintenance Coordinator with you on the road. We
designed the portables software to perform as closely as possible as the way it
performs on desktop computers.
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There are actually two versions of Maintenance Coordinator – Mobile. One is
designed to work on any Palm compatible hand-held computer supporting Palm
OS 3.0 or higher. The other is for use with Symbol SPT portable computers that
also provides barcode scanning abilities. The two applications work the same
except one supports the reading of barcodes where the other does not.
Many programs that work with portable devices write synchronized information
directly back to the main database. This is a nice feature and saves the user a few
steps compared to how we do it. We synchronize information to a special export
database designed specifically for this purpose.
The advance of doing it our way is as follows. First of all, we don’t believe you
want to download all the information from Maintenance Coordinator to the
portable devices, as this amount of information could be extremely large and
quickly fill the device’s available storage. You may also find that it’s better to
only download the information that is relevant to what you want to do. Say all the
work orders belonging to a single mechanic, for example, or just equipment that
use meters, or parts that belong to a single group.
Writing synchronized information to a special database provides a couple of other
advantages too. One, sync operations are much faster with smaller databases. The
portable device’s lookup and sort routines are faster working with smaller
databases, and synchronizing with a special database allows us to work with that
data before writing it back to the main database, such as saving to History logs for
example.
Another really nice feature about the way we do it is that each mechanic can have
their own synchronized (export) database setup, synchronizing only the
information relevant to their job or duties without effecting information used by
others. If you have multiple users working off the same machine, you should
grow to appreciate the fact that each user can have their own export database.
With the above described setup, you could have a working environment
something like the following:
All your mechanics turn over their portable computers to an administrator when
they go home at night. In the morning, that administrator uploads all the changes
those mechanics did the previous day and updates the main databases. The
administrator then downloads new information relevant to each mechanic to their
individual portable computers. When the mechanics return the next morning the
portable computers are handed back out, and the mechanics are set for the day.
The above example is just one of many ways to use this feature. We hope you
enjoy this powerful feature as it also helps to bring you a paperless work order
system to an already powerful and feature rich CMMS system.
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Compatible Devices
The following devices are supported for use with Maintenance Coordinator –
Mobile:



Any hand-held computers with a Palm OS 3.0 or higher.
Symbol SPT hand-held computers
o SPT-1550 or
o SPT-1800

Installing Maintenance Coordinator – Mobile
The following outlines the steps needed to install Maintenance Coordinator –
Mobile onto your hand-held device.









Start Maintenance Coordinator in your normal way.
Navigate to the Portable Devices module.
Click on the Module button and select Prepare to Install to Device
Then select to install to:
o Install to Palm Device (Any Palm compatible computer with an
operating system of 3.0 or higher).
o Install to Palm Scanner Device (Any Installs to any Palm
compatible computer that also support barcode scanning).
Exit all the way out of Maintenance Coordinator
Start the (Palm) Desktop software that came with your hand-held
computer.
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Move to the navigation bar location on the left side of the software and
click on the Install icon.
Browse to the following directory: C:\Program Files\SST\Maintenance
Coordinator.
Select the file: “SST_MC.prc” as the file to install and click Open.
Perform a Hot Sync operation from your portable computer.

Please note that you can install the software designed for Palm Hand-Held on to
any Palm OS 3.0 or higher compatible computer with no problems, including the
one supporting scanners. But you can not install the software designed for
Scanners to any device other than Symbol SPT compatible computers or the
program will not run.

Desktop Software Not Supplied
If your hand-held computer did not come with Palm Terminal Desktop Software
you may want to visit the following web sites to find the software for
downloading:
http://devzone.symbol.com
http://www.palm.com/us/support/downloads/win_desktop.html
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Using the Portable Devices Module
The following section will outline the features of the Portable Devices Module.
Immediately following this section we will outline the Maintenance Coordinator –
Mobile software installed on the hand-held device.

The purpose of the Portable Devices module is to prepare databases to be
synchronized with the databases on portable computers running the Maintenance
Coordinator – Mobile software. It’s also used to write changes made to databases
while on the hand-held device back to the Maintenance Coordinator’s main
databases.
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Completed Work Orders
When a work order has been marked as completed and the Update Main
Database with Uploaded Changes routine is invoked, the following occurs:





Any changes made to the record by the hand-held device are written back
to the main database.
If the “Auto Save to Equipment History” option is turned on, and a piece
of equipment is assigned to the work order, a summary of the completed
task is saved to the Equipment History log.
The completed work order is deleted from the Export/Sync database, but
remains in the main database.
During the next Hot Sync operation, the sync operation should see that it’s
been removed from the Export database and remove it from the hand-held
device too.

Auto Save to Equipment History
This option when turned on will save a summary of a completed work order to the
Equipment History log when a piece of equipment has been assigned to a work
order, and if this option is chosen on the hand-held computer for the effected
work order.

To toggle the Auto Save to Equipment History feature on or off:



Click on the ribbon Module button and select the Auto Save to Equipment
History option.
Answer the popup question as to what you want to do. Turn the feature on
or off.

Note: A highlighted selection indicates the feature is turned on.

Auto Update with Download
When this option is turned on, the program will automatically write any changes
made by the last sync operation back to the main database prior to writing the new
information to the Export database. This has the same effect as clicking the
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Update Main Database with Uploaded Changes button just prior to clicking the
Prepare Database for Device Download button.
To toggle the Auto Update with Download feature on or off:



Click on the ribbon Module button and select the Auto Update with
Download option.
Answer the popup question as to what you want to do. Turn the feature on
or off.

Note: A highlighted selection indicates the feature is turned on.

Install to Device Option
See Installing Maintenance Coordinator – Mobile section for information on this
option.

Create New Export Database
When using this module to build export databases for more that one person, you
will want to create a new Export/Sync database for each person. This way each
person will only see information needed by them in the database, and not a lot of
wasted information not related to their needs. This is great for giving employees
copies of work orders they need to complete, and filtering out work orders they
are not assigned to.
To create a New Export Database:





Move to the Create group in the ribbon and select the New Database
option
With Export Database dialog navigate to where you want to save this new
database. It is suggested that you create a folder to keep these databases in.
Type in a descriptive name in the File Name field, maybe something like
the person’s name that will be assigned to the database (i.e., John
Doe.mdb).
Click the Save button.
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Open or Set Sync Database
Whenever you are about to update information in an export/sync database, it is
necessary to tell the program which export database to use. This is a very
necessary step before any Hot Sync operation is performed. Whichever database
that was last set, will be the one used by the next Hot Sync operation. If you Hot
Sync to the wrong database, any current information in both the Hand-Held
database and Export database maybe changed to a state that it’s not usable.
The path of the last recorded sync/export database is shown on right hand side of
the module’s status bar. The path that is shown on left hand side indicates the
main database path currently used by Maintenance Coordinator.
To Open or Set Sync Database:





Move to Export/Sync Database group in the ribbon and select the Open
Database option.
With the Export Database dialog, navigate to where you have your export
databases stored.
Click on the file name that you want to use, or type it in the File Name
field.
Click the Open button.

Save Current Sync Database
Before you open or set a new sync/export database you should save the current
database to a safe location, this will safe guard its information for the next time
you need to use it.

To save the current Sync Database:





Move to Export/Sync Database group in the ribbon and select the Save
Database option.
With Export Database dialog navigate to where you want to save this
database. It is suggested that you overwrite its last saved name and
directory.
Type in a descriptive name in the File Name field.
Click the Save button.
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Setting Exports / Sync Options
This section outlines the options available for synchronizing the databases on the
hand-held computers and the desktop databases.

Work Orders Export / Sync Options
Placing a checkmark in the Include Work Orders and PMs checkbox will allow
the Work Orders database to be exported to or synchronized with the hand-held
device. Removing the checkmark will delete all the work orders presently in the
export database, and should delete most of them on the hand-held device during
the next Hot Sync operation.
Placing a checkmark in the Append Existing Records checkbox basically does the
following:
It will allow the hand-held database and the export database to synchronize
information during the next Hot Sync operation. If new records are added, they
will be added to both databases, and deleted records will be removed. This is our
recommended way of dealing with the databases.
Removing a checkmark in the Append Existing Records actually deletes all the
records on the export database, and then adds the new records by the criteria you
have set up. If you use this option, you may want to actually delete the
appropriate table from the hand-held device also. Not deleting the table on the
hand-held device could cause duplicate records to appear on the hand-held device.
Some devices however may not allow you to delete a single table without
removing the entire program.
Placing a checkmark in the Download for a Single Mechanic Only checkbox
allows you to download work orders belonging to only a single mechanic. This
option also requires you to select a mechanic to download for.
To select a mechanic for the Export option:







Place a checkmark in the Download for a Single Mechanic checkbox.
Click on the Select Mechanic button.
From the Select Mechanic dialog, click on the Select Mechanic button.
From the Employees Database lookup, locate and click on the mechanic’s
record you want to use from those listed in the grid.
Click the Select button.
Next select the Scheduled Start and End dates of the work orders you want
to include.
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To include all open work orders for the selected mechanic place a
checkmark in the Include All Dates checkbox.
Click the Ok button.

Work Order Parts and Labor Databases
These two database tables are used by work orders in the system to track and
record resources used in the completion of work orders. These two tables
following the same rules that applies to the normal work orders table.

Equipment Export / Sync Options
Placing a checkmark in the Include Equipment Database checkbox will allow the
Equipment database to be exported to or synchronized with the hand-held device.
Removing the checkmark will delete all the equipment records presently in the
export database, and should delete most of them on the hand-held device during
the next Hot Sync operation.
Placing a checkmark in the Append Existing Records checkbox basically does the
following:
It will allow the hand-held database and the export database to synchronize
information during the next Hot Sync operation. If new records where added, they
will be added to both databases. The same holds true with deleted records will be
removed. This is our recommended way of dealing with the databases.
Removing a checkmark in the Append Existing Records actually deletes all the
records on the export database, and then adds the new records by the criteria you
have set up. If you use this option, you may want to actually delete the
appropriate table from the hand-held device also. Not deleting the table on the
hand-held device could cause duplicate records to appear on the hand-held device.
Some devices however may not allow you to delete a single table without
removing the entire program.
Placing a checkmark in the Include Only if using Meters checkbox, will include
only those equipment records that have their Use Meters flag set. This option is
useful for collecting meter readings out in the field.
Placing a checkmark in the Include only if In-Service checkbox will only include
those equipment records that are set as “In-Service”.
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Mechanics Export / Sync Options
Placing a checkmark in the Include Mechanics Database checkbox will allow the
Mechanics database to be exported to the hand-held device. Removing the
checkmark will delete all the mechanics records presently in the export database,
and should delete most of them on the hand-held device during the next Hot Sync
operation.
Note: You are not allowed to edit mechanic records on the hand-held computer.
They are there only for reference and for assigning to and working with work
orders.

Inventory Export / Sync Options
Placing a checkmark in the Include Inventory Items checkbox will allow the
Inventory or Parts database to be exported to or synchronized with the hand-held
device. Removing the checkmark will delete all the inventory items presently in
the export database, and should delete most of them on the hand-held device
during the next Hot Sync operation.
Placing a checkmark in the Append Existing Records checkbox basically does the
following:
It will allow the hand-held database and the export database to synchronize
information during the next Hot Sync operation. If new records where added, they
will be added to both databases, and any deleted records will be removed. This is
our recommended way of dealing with the databases.
Removing a checkmark in the Append Existing Records actually deletes all the
records on the export database, and then adds the new records by the criteria you
have set up. If you use this option, you may want to actually delete the
appropriate table from the hand-held device also. Not deleting the table on the
hand-held device could cause duplicate records to appear on the hand-held device.
Some devices however may not allow you to delete a single table without
removing the entire program.
Placing a checkmark in the Download for a Single Part Group checkbox allows
you to download parts belonging to only a single Part Group. This option also
requires you to select a Group to download for.
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To select a Part Group for the Export option:





Place a checkmark in the Download for a Single Part Group checkbox.
Click on the Select Group button.
From the Group Selection lookup, locate and click on the group’s name
that you want to use from those listed in the grid.
Click the OK button.

Prepare Database for Device Download
This option both writes and deletes records from export database by the criteria
you have setup for the various database tables. It is highly recommended that you
perform an Update Main Database with Updated Changes operation prior to
performing this routine. This will ensure that any changes or synchronized
information is written back to the main databases prior to replacing it in the export
database.
You can have this feature activated for you automatically by turning on the Auto
Update with Download option.
To update the export database with new criteria:




Set or open the Export database you want to prepare.
Set up all export criteria for the various tables as outlined earlier.
Click on the Prepare Database for Device Download button.

Update Main Database with Uploaded Changes
This feature updates the main Maintenance Coordinator databases on the desktop
computer with any changes made on the hand-held computer. In order for this to
work properly however, the two databases need to be synchronized with a Hot
Sync operation prior to performing it here.
To update the Main Database with Uploaded Changes:




Set or open the Export database you want to sync with.
Perform a Hot Sync operation between the hand-held computer, and desk
top computer, and the current export databases.
Click the Update Main Database with Uploaded Changes button.
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Maintenance Coordinator – Mobile
This section will outline the use of Maintenance Coordinator – Mobile, the
software that you use on the hand-held computers. As mentioned before there are
actually two versions of this software. The standard edition and the one made to
be used with Symbol SPT devices. The procedures for using both of these
versions are almost identical, and we will outline the differences as they present
themselves. Basically, if a scanner feature is available it will be highlighted by the
bolded word SCANNER.

Starting Maintenance Coordinator – Mobile
Once installed as outline earlier in this chapter, you will want to run Maintenance
Coordinator – Mobile.
To start Maintenance Coordinator – Mobile:




Turn on the hand-held computer.
Move to the Applications launcher on the hand-held computer.
Locate the SST MC icon and tap it.
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Navigating with Maintenance Coordinator – Mobile
Maintenance Coordinator – Mobile is designed to function much like the fullblown version on your desktop. Like your desktop application, this version is
broken into modules.
To navigate between the modules:



Move to the Main Menu.
Tap on button that best describes the module you want to open.

To get back to the Main Menu just keep closing open screens until the Main Menu
screen appears.

Work Orders (Lookup)
With the Work Orders lookup screen you can locate work orders for viewing,
editing, or you can create new work orders. There are also sort options available
to help locate work orders quickly.

To move to the Work Orders lookup screen:



Move to the Main Menu.
Tap on the Work Orders button.
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To open a Work Order for viewing or editing:


Tap on the work order from those listed.

To locate a specific work order:




Move to the Work Orders lookup screen.
Tap in the Find field.
Enter the Task ID or part of it in the space provided. The list will be sorted
by the information entered here.

To show all work orders by the Default Sort:



Move to the Work Orders lookup screen.
Open the Sort menu and select the Default Sort option.

To show all work orders (including those marked as completed):



Move to the Work Orders lookup screen.
Open the Sort menu and select the Show All option.

To show all work orders assigned to a single piece of Equipment:




Move to the Work Orders lookup screen.
Open the Sort menu and select the Single Equipment option.
From the Select Task Equipment popup, tap on the equipment of your
choice.

SCANNER: To show all the work orders for a single piece of equipment, simply
scan the Equipment’s barcode from within the Work Orders Lookup screen.
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To view the Work Order Details:


Tap on the work orders from those listed.

To Close the Work Order Lookup and Return to the Main Menu:


Tap on the Cancel button.

Adding new Work Orders
To add new work orders:




Move to either the Work Orders Lookup screen or move to the Work
Orders Schedule screen by tapping on the appropriate button in the Main
Menu.
Open the File drop down menu and select the Add Record option.
Edit the new record to your liking, then tapping the Done button to save
changes.

Purging Completed Work Orders
You can delete all completed work orders from the hand-held device, but this is
not really recommended. If you delete them here, completion information will be
lost, and not written back to the main database. It is best to let the Maintenance
Coordinator’s Portable Devices module handle these deletions after it has updated
the main databases.
Also, when work orders have been marked as completed, it will no longer show
up in default sorts. To find completed work orders that are still in the database,
you will have to sort the database by View All.
To delete all completed work orders:



Move to the Work Orders lookup screen.
Open the File menu and select the Purge Completed WOs option.
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Work Orders Details
You can view and edit a work order record from the Work Orders Details screen.
You can also branch to other details from the screen such as to Task Instructions,
Safety Instructions, and Work Orders Status/Completion information.

To edit a work order:











Move to the Work Orders lookup screen or Work Orders Schedule screen.
Tab on the work order you want to edit from within the list, or add new
from the File menu.
Move to the WO Type drop down, and tap on the down arrow located
there.
Now scroll through the list and tap on the work order type you want to
assign to this work order.
Move to the Description field and tap in it. Edit this field to your liking.
Move to the lower section and tap on the two … buttons adjacent to the
date fields.
From the pop-up calendar select the appropriate dates by tapping on them.
To select a piece of equipment to assign to this task, open the File menu
and tap on the Select Equipment option.
Tap on the equipment of your choice to assign it to this work order.
Tap the Done button to save your changes.
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The ? (Question mark) button next to the Equipment field displays information
about the currently assigned piece of equipment, but only if one has been
assigned, and only if it’s in the database.

View or Edit Work Order Instructions
You can edit work order task instructions for all single shot type work orders.
These include the 3-safety related types and the standard work order type. For
recurring work orders, such as a Standard PM, Mini-PM or Change-Over, these
instructions can only be viewed.

To view a Work Order’s Instructions:






Move to the Work Orders lookup screen or Work Orders Schedule screen.
Tap on the work order you want to view or edit from within the list or Add
New from the File menu.
From the Work Orders Details screen, tap on the Instruct button.
To edit the instructions, tap in the instructions field, and edit its contents to
your liking. Tap Done to save your changes.
If the Done button is not visible, this means you can only view the
instructions, in which case tap the Cancel button when done.
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To View a Work Order’s Safety Instructions
Each work order can have safety instructions assigned to them. These are
assigned by the Maintenance Coordinator desktop application and are not editable
on the hand-held.
To view a Work Order’s Safety Instructions:





Move to the Work Orders lookup screen or Work Orders Schedule screen.
Tap on the work order you want to view or edit from within the list or Add
New from the File menu.
From the Work Orders Details screen, tap on the Safety button.
When you are done viewing the safety instructions, click on the Cancel
button.

Work Order Parts
You can add parts to be used in the completion of work orders with the mobile
software much like you can with the desktop software.

To add or record parts used for work order completion:


Move to the Work Orders lookup screen or Work Orders Schedule screen.
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Tap on the work order you want to view or edit from within the list.
From the Work Orders Details screen, tap on the Parts button.

To add a part to the work order:




Tap the Add Part button.
From the Select Inventory Item lookup screen tab the part that you want to
add from those listed.
Tap the Select button

To edit the quantity needed or used:




Tap on the part you want to edit the quantities for from those listed.
Move to the appropriate fields and edit the information to your liking.
Click the Save button.

To delete a part from this work order:



Tap on the part you want to delete from those listed.
Move to and click on the Remove button.

Work Order Labor
You can add labor needed or used in the completion of work orders with the
mobile software much like you can with the desktop software.

To add or record labor used for work order completion:




Move to the Work Orders lookup screen or Work Orders Schedule screen.
Tap on the work order you want to view or edit from within the list.
From the Work Orders Details screen, tap on the Labor button.

To add a mechanic to the work order:



Tap the Add button.
From the Mechanics/Employees lookup screen tab the mechanic that you
want to add from those listed.
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Tap the Select button

To edit the man hours needed or used:





Tap on the mechanic you want to edit the hours on from those listed.
Move to the appropriate fields and edit the information to your liking.
Click the Save button.

To delete a mechanic from this work order:



Tap on the mechanic you want to delete from those listed.
Move to and click on the Remove button.

View or Edit Completion or Status Information
You can view or edit a work order’s status and completion information in the
program, and have this information written back to the main databases.
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To record Status and Completion Information:














Move to the Work Orders lookup screen or Work Orders Schedule screen.
Tap on the work order you want to view or edit from within the list or Add
New from the File menu.
From the Work Orders Details screen, tap on the Status button
Move to the WO Status drop down, and tap on the down arrow located
there.
Now scroll through the list and tap on the work order status type you want
to assign to this work order.
Tap on the … button adjacent to the Date Done field
From the pop-up calendar select the appropriate date by tapping on it.
Tap on the … button adjacent to Completed By field.
Select a mechanic from the popup list and then by clicking on them from
within the list.
Click the Select button.
To have the Mobile Device module write completion information back to
the equipment history log, place a checkmark in the Save to Equipment
History Log checkbox.
Move to the Completion Comments/Delays field and tap in it. Now edit
this field to your liking.
Tap the Done button to save your changes.

Maintenance Coordinator  Simplicity Software Technologies Inc.

27

Portable Computers
Work Orders Schedule
The Work Orders Schedule module works much like the Work Orders (Lookup)
module as it allows you to select work orders for viewing or editing. The main
difference between the two is how the work orders are sorted. With the Work
Orders Schedule module work orders are sorted or grouped by scheduled start
dates.

To move to the Work Orders Schedule module:



Move to the Main Menu.
Tap on the Work Orders Schedule button.

To open a work order for viewing or editing:


Tap on the work order from those listed.

To locate a specific work order:




Move to the Work Orders Schedule screen.
Select the date you think the work order is scheduled to start.
Tap in the Find field.
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Enter the Task ID in the space provided. The list will be sorted by the
information entered here and by the selected date.

To change the dates of the Work Order Schedule:







Tap on the day-of-the-week button that you want to see scheduled work
orders for.
Tab on the left arrow to move the dates backwards one week at a time.
Tap on any of the weekday buttons to view the tasks schedule to start on
that day. The selected date will appear in the caption area
Tab on the right arrow to move forward one week at a time.
To go to today’s date open the Dates menu and then tap the Today option.
To select a specific date, open the Dates menu and tap the Select Date
option. Then select the appropriate date from the pop-up calendar by
tapping on it.

Equipment Database
The Equipment Database allows you take information with you about your assets
or equipment. This information is used with work orders, when assigning
equipment to work orders is necessary. It also helps to simplify the collection of
meter readings by taking the appropriate information with you out to the field.
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To move to the Equipment Database:



Move to the Main Menu
Tap on the Equipment Database button.

To open an Equipment record for viewing or editing:


Tap on the equipment record from those listed.

To locate a specific asset:




Move to the Equipment Database.
Tap in the Find field.
Enter the Equipment Reference in the space provided. The list will be
sorted by the information entered here.

SCANNER: To quickly find a piece of equipment, simply scan the Equipment’s
barcode from within the Equipment Lookup screen.

Equipment Details
The Equipment Details screen allows you to view or edit information about your
equipment and other assets. This is also where you would record meter readings.
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To view or edit an Equipment record:






Move to the Main Menu.
Tap on the Equipment Database button.
Tap on the equipment record from those listed to move to the Equipment
Details screen.
Tap in the various fields on this screen and edit the information found
there to your liking.
Tap the Done button to save your changes and exit this screen.

Inventory Database
The Inventory Database allows you take information with you about your parts
and inventory. This information will come in handy for part room activates such
as checking in parts, and removing parts from inventory. It will also help
streamline inventory counts.

To move to the Inventory Database:



Move to the Main Menu.
Tap on the Inventory button.

To open an Inventory record for viewing or editing:
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Tap on the inventory record from those listed.

To locate a specific part:




Move to the Inventory Database.
Tap in the Find field.
Enter the item’s Reference in the space provided. The list will be sorted by
the information entered here.

SCANNER: To quickly find an inventory record, simply scan the item’s barcode
from within the Inventory Lookup screen.

Parts Details
The Parts Details screen allows you to view or edit information about your
inventory items. This is also where you would record current inventory levels.

To view or edit a Parts record:




Move to the Main Menu.
Tap on the Inventory Database button.
Tap on the inventory record from those listed to move to the Parts Details
screen.
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Tap in the various fields on this screen and edit the information found
there to your liking.
To adjusted inventory levels up, tap on the + (plus) button. To adjust
inventory levels down, tap on the – (minus) button.
Tap the Done button to save your changes and exit this screen.

Mechanics Database
The Mechanics Database is used as reference material, and for assigning to
various parts of work orders. This information is not editable from the mobile
software, as it is with the other database.

To view a mechanic’s record:





Move to the Main Menu.
Tap on the Mechanics Database button.
Tap on a record from those listed to view the limited information
provided.
Tap on the Cancel button to exit this screen and return to the Main Menu.

To locate a specific mechanic:




Move to the Mechanics Database.
Tap in the Find field.
Enter the item’s Reference in the space provided. The list will be sorted by
the information entered here.
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PORTABLE DEVICES – ACCESS DATABASE
SYNCHONIZATION
This document outlines the use of the Portable Devices – Database Synchronization
Routines.
Please note that because of the nature of these routines a Site/Network License must have
been purchased to use these routines.

Overview
With the introduction of Windows 8, Microsoft has added support for the use of tablets
and other mobile based devices. With this in mind, we too decided to add more support
for mobile devices by developing a new feature for our Portable Devices module.
The Synchronization routines can be used to synchronize databases on your local
computer, on a remote server, or with databases stored on the internet (Cloud
storage). This allows mobile use with laptops, Windows tablets, and more. This
added ability allows use with disconnected databases while in the field or working
in a remote location. When back in the office you can synchronize your databases
updating both the Master and Replica databases with new and changed data.

Accessing the Access Sync Routines
To access the Access Sync Routines:



Click on the Portable Computers button from within the Main Menu of Maintenance
Coordinator.
From the Portable Devices module, move to the Shortcut bar on the far left of the
screen and click on the Access Sync Routines button.
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Making a Database Replicable
The first step in enabling replication is to create a Master Database. The Master Database
is where you make structural changes to the database that you will be disperse to the
replica set; changes to data are made in the replicas contained in the replica set. Making
a database replicable makes the database a Design Master.
Important The process of making a database replicable can't be reversed. It is strongly
recommended that you make a backup of your database before performing this operation.
To convert a normal database to make it a Deign Master (Replicable Master):






Open the Application menu in the upper left hand corner of the ribbon control by
clicking on it.
Click on the Convert Master Database option.
Browse to and select the Access database that you want to make a Design Master.
Click on the Open button.

Creating a New Replica Database
Next you need to create one or more Replica Databases that will be used on the mobile or
remote devices. This new replica will be used to sync information with the Design
Master we made in the previous step.
To create a new replica database:



Move to the Master Database Path section and click on the Browse button found there.
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Browse to and select the Access database that you want to use as the Design Master.
Click on the Open button.






Click on the Create New Database button in the ribbon.
Browse to where you want to save this new database at.
Move to the File Name field and type in a name for this new database.
Click the Save button.

Performing a Synchronization on Two Databases
Once you have your Master and Replica databases setup, and you have some changes in
either database you may want to perform synchronization on these two databases. The
paths of these databases can be on a local drive, be on an indirect drive or stored on the
internet.
The following are examples of acceptable paths for the synchronization of databases:
Master Databases
Replica Databases
c:\NorthwindDM.mdb
c:\Data\OrderEntry.mdb
c:\NorthwindDM.mdb

c:\NwindReplica2.mdb
www.mycompany.myserver.com/files/Orders.mdb
\\MyRemoteServer\MyShare\NwindReplica.mdb

To sync your databases:







Move to the Master Database Path section and click on the Browse button found there.
Browse to and select the Access database that you want to use as the Design Master.
Click on the Open button.
Move to the Replica Database Path section and click on the Browse button found there.
Browse to and select the Access database that you want to use as the Replica.
Click on the Open button



Move to the ribbon and click on the Perform Synchronization button.

NOTE: In place of using the Browse buttons you can also type in the paths for both of
your databases in the spaces provided.
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Setting the Master Database Path
There are two main methods of setting the Master Database Path





Move to the Master Database Path section and click on the Browse button found there.
Browse to and select the Access database that you want to use as the Design Master.
Click on the Open button.

Or you can…




Move to the Master Database Path section and click on the down drop list found there.
Select the database you want to use by clicking on it.
Click on the Set from List button.

Note: The drop down list is populated from the database that are currently setup and in
use by the Maintenance Coordinator system.

Saving Sync Settings
If you have synchronization settings that you reuse often it maybe to your advance to
save these settings to file for easy reuse.
To save sync settings:







Setup both the Master Database Path and the Replica Database Path.
Click on the Save Settings button in the ribbon.
Browse to where you want to save this new setting.
Move to the File Name field and type in a name for this new file.
Click the Save button.

Maintenance Coordinator  Simplicity Software Technologies Inc.

37

Portable Computers
Open Sync Settings
If you have synchronization settings saved to file that you would like to reuse:





Move to the ribbon and click on the Open Settings button.
Browse to where you have your settings file saved.
Select the file and click Open.
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